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Installation and Un-installation Instructions 
Please read the section on installation carefully. Incorrect installation may invalidate your licence. 

 

 

 

Login 
Your system is delivered with the following information set in.  

Please change this using the Admin>Authorised Users from the menu if security is an issue. 

 

USER NAME  Superuser 

PASSWORD  Demo  

 

 

 

Licence 
The licence agreement is at the rear of this manual. Use of the system implies your agreement to 

all copyright conditions and full agreement to the licence conditions for this software. 

 

 

 

Support 
Support on Liberate is available to you on an unlimited basis. 

Please call Liberate Estimating 

Tel +44 + 01252 795030 

Email  info@libr8.co.uk 
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 FUNCTIONS LIST LIBERATE EDITION 5 

 

Function  

New Functions in the latest release  

A new interface design  

The Outputs Feature  

Multiple select, Save Move or delete  

Comments on Items   

Calculation pad at Items levels  

Reports to complement new features  

  

  

Security  

Login only approved user(s).  
User can only access Jobs designated to each user’s level i.e. set who can see which jobs as 

appropriate.  
 

Administrator level can add new users and set who sees what  
Set which users can administrate the libraries.  
   

The Job Screen  

Create a new Job and control all of your resource costs, labour hours and profits from a single 

easy to use screen 
 

Duplicate any Job and use the duplicate to submit variations on your tender  

Change the default labour rate to fine tune tasks that use the default labour rate  

Use other labour rates from a library of other labour rates  

Get instant feedback on how many man days there are in your Job.    

Adjust the "Hours per day" figure to cope with winter or summer,  long distance or other 

difficult working conditions  
 

Set the type of estimating: Normal or frequency based estimating. Frequency based is turned 

off by default 
 

Backup one or many Jobs to enable portability of Jobs or just to backup for safekeeping  

Start new jobs with default mark-ups as set in in the options  

  

The Items Screen -Your main Estimating Screen  

Create new tasks from first principals using "normal language”  You are not tied in to 

Surveyor speak and can produce quotes and schedules in the jargon  appropriate to your 

clientele. 

 

Take off pads record your measurements and calculations. No limit to the number of takeoff 

pads you can use in any task. Take off pads can be set against each material resource  
 

Take off pads as above against each plant as well as material resource  

Add resources to a task even if the resources do not exist in your library  
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Function  

Save a built up task to your items library to retrieve again in the future. You'll never have to 

build up the task again - no matter what the size or quantity 
 

VAT. Optionally add VAT to your Job  

Find and Replace resource; Replace a resource with another throughout your Job  

Spell check at Items level  

  

Items Library  

Select one item at a time from the items library.   

Select multiple items from multiple categories, review a schedule of what you have selected 

and bring these all into your B/Q at the same time. 
 

Insert Library item at any point on the build up page.  

Combine multiple Library items. Select two or more items and combine them into one item. 

On each item you will be asked for the individual quantity of that item required to make up 

the quantity of the new item. You would then be able to store the new item back to the 

library  

 

Import of library item into existing item. This would allow an assistant to type in/scan 

in/import a list of bill items. The relevant library item would then be retrieved into the 

current item. 

 

Select items from the library by Category, Code, Original Job or Keyword  

Create new categories from your build up page to save directly into the Items library  

Separate program for library administration. The library can be updated in a multi-user 

environment whist the estimator works on the pricing 
 

Retrieved items will automatically update with the current library labour rates and resource 

prices 
 

There are two completely separate library sets; Users can set which library they wish to 

address. E.g. Building works or Civil Works. You can custom name the libraries as you wish 
 

  

Resource Libraries  

You have 4 Resource Libraries; Materials Labour Plant Sub Contractor. Each library activated 

depending on which resource screen you are on 
 

Quick search from hotkey. Type the first few letters of a required resource and the Liberate 

search engine will bring up a list of resources that match.  
 

Change prices in libraries will not automatically update your Job - Update only the Jobs you 

want to update 
 

Enter Pack size in Library for calculation of full packs required by your Job. Liberate will advise 

you on allowances to make to full pack size. (Material and Plant) 
 

Enter Waste factor in your resource library  

Enter Supplier discounts in your resource library  

Import electronic supplier lists Next year’s import will not overwrite discounts so you can 

update each year electronically 
 

Search by supplier, category, description or code or a combination to find the resource you 

require 
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Function  

Update selected resources by a %  

Export to an Excel file for updating and re-importing  

Automatic date against each resource entered in the resource library. This will enable you to 

see the date when you last updated this resource. The date update will only change if there 

are changes to the price of the resource 

 

Item Screen Functions   

Build up the extent of your task – not a single unit. See screenshot for explanation  

Add as many different resources into each resource type as you wish to fully describe each 

aspect of the task. The estimate then becomes the site task schedule when the Job is won 
 

Set header items  

Exclude items in your Bill from the final totals (lets you provide alternatives that don’t add in 

to the final total 
 

Apply individual mark-ups to resources to exclude them from the global mark-ups  

Set any item or resources as a provisional sum to be summarized separately  

Undo up to 12 levels of deletions  

Bookmark multiple items   

Find or Find and replace a resource with another resource in one location or throughout your 

job 
 

Estimate using the frequency option (This must be switched on from the Job screen)  

Multi-user functionality  

Your Jobs and Library database will have multi-user capability. If you are on a network your 

entire team or organization will be able to use the same library and Jobs databases 
 

  

  

Bill of Quantities Import  

Import Electronic Bills of quantity into the system for pricing in your clients format  

  

Master Jobs  

A master job will control a number of sub Jobs. This will mean that if a Job is divided into 

different sections say Earthworks, Pavings, Walls, Water features. Each section will have its 

own Sub totals and reports. There will also be reports for the Global Job. 

 

  

Job Folders  

Jobs stored in a folder system. Folders can be named by yourself e.g. Big Jobs Small Jobs Old 

Jobs etc. You will be able to have as many folders as you like for storing or organizing your 

jobs 

 

  

Frequency Option  
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Function  

This is a switch able option mostly designed for maintenance estimating where tasks are 

repetitive over a period such as facilities management ground care or railway maintenance 

You are get totals and reports on a per occasion or per annum basis or a combination of both. 

 

  

Overhead and Profit  

Add percentages to 2 decimal places for each resource type globally or at individual task level  

Add an overhead % to your Job separately from the profits  

  

Database Check and Repair  

Accessed from the Admin menu to optimise the database. Should be run frequently to 

safeguard data 
 

  

Reports  

A fully functional set of reports for both issue to client and project management  

Reports may be issued with options of  “At cost, With profit or even have prices left out  

Reports for master jobs and sub jobs using the current set of reports  

Reports of required revenues/resources for selected jobs or jobs between selected dates  

Project management reports on expenditure to date and required expenditure. Using master 

job functions 
 

Add logos and standard text your BQ report  

  

Administrative version  

A free administrative version is now available for all multi user systems. This has reduced 

functionality 
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INSTALLATION - LIBERATE EDITION 5 -   PLEASE READ CAREFULLY  

 

We are assuming that all installation is to the local drive - C:\  Please substitute any other drive 

if appropriate. The drive must be on your local machine 

 

NETWORKS 
Liberate is suitable for network installation if you have purchased the multi-user version.  

A different installation package will be sent to you if you wish to install the network version 

 

Warnings 

There are no warnings at the time of publication of this manual.  

 

ACTIVATION 
Your Licence must be activated before you can run the program  

Please note that this programme has a copy protection facility. 

You will need to activate the program before it will run. 
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INSTALLATION - LIBERATE  EDITION 5 -  PERSONAL EDITION  

1. Close all programmes until you only have your desktop showing on your screen.  

2. Use [Start] [Run] and [Browse] to find PESetup.exe If you have downloaded the 

programme from our website then it will be in a default download directory).  

3. Use [Select] when you have located PESetup.exe then [OK] to run the file.  

4. Liberate will then begin to load onto your computer.  

5. You will be asked to accept our Licence Agreement.  

6. You will be asked for confirmation to create a Liberate directory on your computer. 

The default position is on the C drive (C:\Program Files\Liberate) or C:\Program files 

(x86)/ Liberate - if you would like it created elsewhere then adjust the programme path 

by using [Browse].  

7. If you already have a Previous Version of Liberate on your computer this will be 

automatically detected and you will be given some important information about 

upgrading 

8. (Your existing copy will bill be left intact and you will have a separate copy of V4 on 

your machine)  

9. The following screen will ask which libraries and jobs databases to install - select 

[Sample Jobs and Library Databases] and click [Next] to commence the installation.  

10. Liberate will install and will indicate when it has been installed successfully (usually 

takes approximately 1 minute).  

11. Close down the installation programme by clicking [Finish] 

 

FILE LOCATIONS 

• The program is installed by default to the C:\Program files\ or (Program files X86) 

directory (You can vary this) 

• The Databases are installed to the folder 

C:\Users\user_name\AppData\Roaming\Liberate\ Liberate PE  (you cannot vary this) 

• Data bases are installed to a user defined location on the Multi user system – See 

help /About and the I button from within Liberate 

• Licence data is in a hidden folder C:\Program Data\ JR 

• Other Liberate data is also in C:\ProgramData\Liberate 

• Note If these are not visible as these are hidden directories you would need to Use 

the Windows View Options to show hidden files and folders. 

• Please ensure you back up the Jobs and Library folders found as above - regularly 

 

ACTIVATION 

12. . There will be a "Liberate" symbol shortcut on your desktop:- Or go to the Program 

Group Liberate PE 

 Click on the Desktop Shortcut and you will be asked if you wish to activate your 

programme; Follow the procedure through by pressing the OK Button. You will be 

connected to the internet.  

 Choose Install as a Trial if you do not have a licence key or see below if you are an 

existing user. 
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 You will be asked to register and a verification email will be sent to you. Once you 

have verified your email address by clicking on a link sent to you your program will 

start. You are now ready to Login.  

 Username: Superuser 

 Password: Demo 

 

We suggest that you now familiarise yourself with the system and then arrange for free 

telephone based training at a time and date that is convenient to you.  
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RE- INSTALLATION FOR EXISTING USERS - LIBERATE EDITION 5 - 
PERSONAL EDITION 

 

MOVING LIBERATE TO ANOTHER COMPUTER 
 

Generally 

If you are installing to a new computer and you already have a licence key: 

 

• Personal edition and Multi-User client. Download the latest Version from Support 

page at www.libr8.com/support 

• Reference your licence key from the information button which is 

accessed from the Help menu and then About  

• Or ask us to send you your licence key. 

• Use this licence key to install your system as a Standalone - you will not have to 

reregister. 

• Do not use your system more than 3 times in any 40-hour period times on your old 

machine as this will lock up both machines. 

• Once you have installed Liberate on your new machine transfer the databases from 

your old machine to your new machine. 

• Make sure that Liberate is closed on both Machines when you do this. 

 

Personal Edition 

• The databases in two folders called Jobs and Library at: - 

C:\Users\user_name\AppData\Roaming\Liberate\Liberate PE. 

• Note that the Folder called AppDate is a hidden folder. You need to tick the tickbox 

in your File explorer View settings on the top menu 

  
• Copy the folders from the old machine and replace the folders on the new machine 

• Please be careful not to lose your data and if you are unsure please call us.  
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Multi-User Version 

• The databases for the multiuser version are referenced from Help/ About – Info 

button but would be user selected in any case. 

• Multi-user server. Please request this file and your key. 

•  

 

Warning  

Both versions of Liberate (old and new machines must be closed) 

You will destroy any data on your new machine once you replace the databases 

 

A short tutorial on how to use Liberate is at the back of this manual 

  



 15 

INSTALLATION –MULTI USER - LIBERATE EDITION 4 -   PLEASE READ CAREFULLY  

 

NETWORKS 
Liberate is suitable for network installation if you have been supplied with the multi-user version.  

 

WARNINGS  
 

INSTALLATION FILES 
• Please download the latest files from our website using the links given to you. Files which you 

have downloaded previously may have been updated. 

 

ACTIVATION 
• Your Licence must be activated before you can run the program.  

• Please note that this programme has a copy protection facility. 

• A verification email will be sent to the address you register. If you do not receive this please 

check your Junk mail box or call us. 

 

OVERVIEW OF PROCEDURE 

The multi user version is delivered in two files. 

Server installation: This must be installed to a shared drive running Windows software. It is not 

suitable for installation on attached devices 

 

File 1 is installed as one of two options below 

File name: libr_mus_install_4.exe  (mus =multi user server) 

 

1A Option A  Standard Servers   

Read section A below if you will be installing your software onto a standard network server or 

where you have multiple PCs connected together over a network and a PC is designated as a server. 

You can ignore Option B 

 

1B Option B   Terminal server installation 

Users can log in remotely or users working in an office environment will connect to their data over 

a conventional network with the added benefit of remote login. You must have a Terminal server 

to use this option. If you are not sure use Option A 

 

2 Client installation for all users. 

File name:   libr_muc_install_4.exe (muc =multi user client)  

 

File 2 is installed to all machines which will be used by each user to access the Liberate Jobs and 

Library databases. 

This is installed on each client PC with its own licence. 

 

Other information before starting 

• You may need Administrator rights to install on a network. 

• The installation folder for the databases must be set to share  

• Read /Write access should be set automatically for the Liberate data folders. 
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CLARIFICATIONS: (we have mentioned this previously) 

Server 

• The server file is installed on the server machine and contains the databases. The Server file 

should only be installed once initially.  

• Any updates issued by Liberate are designed not to reinstall the database files but to only 

update the server software. 

• It is however advisable that before reinstalling the Multi user server (MUS) program that the 

databases are backed up to prevent loss of data. 

 

Client 

• Used for all standard installations 

• The Client files are installed on each separate client machine and point to the shared 

databases. 

• Each client has a separate licence. 

 

Terminal server installation 

1. Where a terminal server is used to login from outside the office environment, a desktop 

shortcut on the terminal server allows a maximum number of simultaneous licenced users to 

login.  

2. This desktop shortcut is added by the administrator to the libr_mus.exe file installed in the 

Liberate program folder on the terminal server and requires its own licence key if this type of 

system is being used. 

 

 

INSTALLATION PROCEDURE – MULTI-USER EDITION FOR NETWORKS 
 

SERVER FILE INSTALLATION 
There are two types of installation options.  

• If you are installing a standard Windows server use Option A. (This is the most likely option) 

• If to are installing to a Terminal server or a LAN use option B  

 

OPTION A:  
For Normal Windows Server installations: 

 

1. The server file must be installed first. 

2. Run the file libr_mus_install_4.exe at the server machine. 

3. You cannot run the server file using an UNC path (\\Server). You must install at the server or 

user remote desktop. 

4. The Program will be installed by default to C:\Program Files (x86)\Liberate\Liberate MUS. You 

can vary the default program files path. 

5. On the next dialogue you will see a dropdown box “Install database files only”. Accept this if 

you are installing to a normal server. 

6. Note for reinstalling: Liberate will not reinstall new databases if it detects a Jobs and Library 

folder. We do suggest however that you make a backup for security of your data if reinstalling 

7. The data files containing all user created data will be installed to a folder of the user’s choice 

on the server machine. Its best to pre-create this folder (e.g. Liberate V4 Data) but you can 

make a new folder at this point. 

8. Choose empty or sample databases. (Existing databases will not be overwritten but it’s best not 

to take a chance Please make a backup of Jobs and Library folders) 

9. The installation will complete. 

10. You must now install The Multi user client on each client machine. See below go to Section 2 
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OPTION B: SKIP IF YOU HAVE USED OPTION A 
Only for Terminal server installation or if you have been instructed by Liberate to do so. Choose the 

Terminal server option from the Select database files dropdown when asked. 

Before installing this option please ensure that we have supplied you with a licence key configured 

for Terminal servers. 

1. Run the file libr_mus_install_4.exe at the Terminal server machine. 

2. You cannot run the server file using an UNC path (\\Server). You must install at the server or 

use Remote desktop. 

3. The Program will be installed by default to C:\Program Files (x86)\Liberate\Liberate MUS. You 

can vary the default program files path. 

4. On the next dialogue you will see a dropdown box “Install database files only”. Change this to 

the “Install files for a terminal server”. 

 

Note for reinstalling: Liberate will not reinstall new databases if it detects a Jobs and Library 

folder. We do suggest however that you make a backup for security of your data if reinstalling 

5. The data files containing all user created data will be installed to a folder of the user’s choice 

on the terminal server machine. It’s best to pre-create this folder (e.g. Liberate V4 Data). You 

may create a new folder at this point using the New folder button on the dialogue box. 

6. Choose empty or sample databases. (Existing databases will not be overwritten of you are 

reinstalling but its best not to take a chance. Please make a backup of the Jobs and Library 

folders) 

7. The installation will complete. 

8. The libr8sever Configuration box will appear with the Start-up mode selected for Windows 

service and the Network service as Automatic 

9. Press “Start”  

10. If this does not appear please start this manually from 

C:\ProgramFiles\Liberate\Server\Libr8server.exe 
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11. You will now be asked to allow the service to automatically configure your firewall. Accept this 

12. The LIBR8V4 Product registration dialogue will appear 

 

13. Choose “Configure as a network server” and enter the key which we have given you. (If you 

don’t have a key at this point please abort and request a key) 

 

Once the Key is entered you will receive 

this dialogue 

 

 

 

14. Press finish to complete the installation. 

If you intend to allow remote login, administrators should now add a shortcut to the desktop of the 

terminal server pointing to the file “\Liberate MUS\libr_main.exe”. (We deliberately do not add this 

as a default during our installation to prevent unintended use of the server files when installed on 

a terminal server.) 
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15. Run the file “\Liberate MUS\libr_main.exe:- The following dialogue will appear 

• You can run this from The <All Programs> list from the start button 

• You should add a shortcut to your desktop for each server user  

 

  
There are now two options for users:- 

 

Users running from the terminal server 

Your licence will have been set for a maximum number of simultaneous users 

Users should use the Terminal server desktop created shortcut to start the program 

Users logging in to the terminal server should run the program from the shortcut created on the 

terminal server. 

 

Users working on the local environment should run the program from their client machines.  

16. You must now install the multi user client file on each client machine. See below 

 

Firewall notes for Option B only 

The installation will configure your firewall and allow access via port 10589 if you have been given a 

network key for a terminal server. In most cases you needn’t need to be concerned with this issue. 

If this hasn’t been done automatically please allow network traffic at this location. 

 

Sharing (for all installations) 

• Shares and read write access should be set up automatically directory where you have installed 

your data (Jobs and Library databases).  

Read Write Access (for all installations) 

• This should be set by the program installation but if you are having problems you should check 

that this is set. 

•  

 

SECTION 2 – ONLY IF YOU HAVE INSTALLED OPTION A 

CLIENT FILE INSTALLATION  
To be installed on each PC accessing the shared database. 

MULTI USER CLIENT INSTALLATION (MUC) 

You will need this file:  libr_muc_install_4.exe (MUC = multi-user client file) 

 

Close all programmes until you only have your desktop showing on your screen.  

1. Locate the file which you have downloaded 

2. If you have downloaded the programme from our website then it will be in your default 

download directory usually Documents\downloads  

3. Liberate will then begin to load onto your computer.  

4. You will be asked to accept our Licence Agreement.  

5. The following screen contains Installation Notes (see appendix 2).  
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6. You will be asked for confirmation to create a Liberate directory on your computer. The default 

position is on the C drive (C:\Program Files or (x86)\Liberate) - if you would like it created 

elsewhere then adjust the programme path by using [Browse].  

7. You will be asked to identify the folder on your Server where the Multi-User Server database 

has been previously installed. Use [Browse (and browse via Network to find this programme 

and select the Liberate MUS folder, click [OK] then [Next]. 

8. Liberate will install and will indicate when it has been installed successfully (usually takes 

approximately 1 minute).  

9. Close down the installation programme by clicking [Finish]. There will now be a "Liberate" 

symbol shortcut on your desktop - Click on this and you will be asked if you wish to activate 

your licence. 

 

(Alternatively: - Use [Start] > [Programs] > Liberate V4 Multi-User Client) 

10. You will be asked to choose an installation type 

11. Install as a trial and we will upgrade your system before your trial ends if appropriate. 

12. If you have supplied with a key or are reinstalling please install as a Standalone and you will be 

asked for the key. If you don’t have your key we will email it to you. 

 

Activation 

You will need to activate the program before it will run. 

 

If you are already registered 

If you are already registered please request your original key and install as a Standalone when asked. 

 

If you are installing for the first time 

If you are installing for the first time please install as a Trial 

You will be asked to register and a verification email will be sent to you. Once you have verified your 

email address by clicking on a link sent to you your program will start. You are now ready to Login 
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LOGIN 
To start Liberate double-click on the green icon on your desktop. Your system is delivered with the 

following user information set in so use these to login for the first time.  

 

User Name  Superuser 

Password  Demo  

 

You can add yourself or others by this using the Menu [Admin]> [Admin Program] and add/delete 

authorised users as appropriate from the menu if security is an issue. We would recommend at least 

having your own login name as it is easier to remember than “superuser”…… 

 

Check your version 

You can check version numbers Installation paths etc via the Help/About accessed from within the 

program and then the Information button shown on that dialogue. 

 

For further information see User Levels and Security. 

 

Licence agreement 

Use of the system implies your agreement to all copyright conditions and full agreement to the licence 

conditions for this software. A copy of the licence agreement is in the online manual and you agreed to 

these conditions at an earlier stage of the installation. 

 

SUPPORT 

Support on Liberate is available to you on an unlimited basis. We can offer support by telephone and 

online. 

 

Please contact Liberate Estimating by: 

 

Tel +44 + 01252 795030 

Email: info@libr8.co.uk 
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A QUICK RUN THROUGH THE SYSTEM 

 

 

OVERVIEW 
See the Tutorial for details 

 

IMPORTANT KEYS 
The following are the most commonly used keystrokes. All of the following functions are 

duplicated in the Menu or by using the Icons. Hover over the Icons on the toolbar to see a 

description of its use 

F12 = Append new record 

Insert = Insert new record 

F9 = Retrieves an Item or a resource to the relevant library depending which screen you 

are on 

F10 = Saves an Item or a resource to the relevant library depending which screen you are on 

Ctrl+Del = Delete record 

Ctrl+S = Save your last entry  

 

When the Ctrl key is used this is used, press this simultaneously with the key indicated keeping 

both keys depressed. 

 

(A record is any new line of information) 

 

A Basic Build-Up 

This section provides an overview of the Liberate estimating system concept. Please see the 

Tutorial in the next section for more detailed step by step information 

1. Start the program 

2. Enter your User name and Password The system is despatched with the following  

User name - Superuser                                      

Password - Demo 

3. On the Job Screen: Select an existing Job or add a new job (MENU >JOB>Create new empty 

Job) 

4. Set up the default labour per hour rate in the Labour Rate box. This rate will be reflected by 

default in every labour record in this Job. You can change the default at any time and all labour 

records will update accordingly. You can use other rates from the labour library as well. These 

rate will be linked to your library and reflect any changes made in the library when you run 

connect 

5. Set up the hours per day in the Hours\Day Box. At any stage you will know exactly how many 

mandays are allowed in your Job 

6. If you want to at this stage, set in the Job mark-ups on the various resource types 

7. Press the I Icon to go to the Items screen (Bill of Quantities) 

8. Add  a new Bill item F12 (to append) or INSERT    

9. Add a Description in the Memo Box 

10. Add a Code Quantity and Unit 



 23 

11. Go to any of the resource screens (Materials, Labour, Plant and Sub-Contractor (Click the Tab 

or the M or I or P or S  Icon or press ALT+M  (or L or P or S) 

12. Add  an new line (F12) 

13. Add materials  as required to build up the item (F9 searches the active Resource Library Br and 

F9 whist on the material screen would bring up all of your materials starting with Br (such as 

bricks) 

14. Add a quantity or use the take off pad to calculate your take offs and input a quantity for you 

15. Go to the other resource screens for this bill item (Click the Tab or the L Icon or press ALT+L  

16. Add  a new line (record) 

17. Add the necessary labour tasks to build he current Item The Default labour Rate is set on the 

Job Screen but you can use F10 to access the Labour Library and use different rates 

18. Go to Plant (Machinery) and Sub-Contractor resource screens in the same way (By Icon or by 

clicking the tab or ALT+P or ALT+S) 

19. Run Connect from the menu or Icons to update your Job with any changes you may have made 

in the resource library 

20. Save the built-up item to the ITEMS LIBRARY to use it in future on another Job.  

21. Set or adjust Job Mark-ups on the Job Screen 

22. Set or adjust Item mark-ups on the Items screen. if you want to mark this item up individually 

23. View profit margins and profit values on screen and adjust as necessary 

24. View rounding errors and compensate by increasing the amount of decimal places displayed 

25. Print Reports to your printer or direct to your fax (e.g. Travis Perkins collated materials for this 

Job) 

26. Download Reports to your spreadsheet or Word Processor 

27. Run a duplicate Job to manage and control the management of your project once you have 

been awarded the contract 

28. Download Reports to your spreadsheet or Word Processor 

29. Run a duplicate Job to manage and control the management of your project once you 

have been awarded the contract. 
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GLOSSARY OF TERMS USED IN THIS MANUAL 
 

Append     Add to the end of 

Insert  To place between. 

Field   A single box for inserting or displaying information on a record e.g. 

Description or Quantity or Unit 

Record  A row of information consisting of a number of fields 

Database  A collection of records 

Tab  The key on your keyboard with the opposing Left right arrows. Next 

to the Q 

Build-up  The process of adding resources to a task in order to define all of the 

requirements to do that task 

Resource  Materials Labour Plant or Sub contract details required to perform a 

task 

Item   A collection of resources 

Mark-up The percentage which is applied to the cost to arrive at the sell price 

for the job 

 MCD 

 Main Contractors 

 Discount 

 MC Disc 

This allows for main contractors discount. It adds on a specified 

amount which will later be deducted as a discount 
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CONVENTIONS USED IN THIS HELP 
The following terms are used: 

Mouse:  Use your mouse to perform this function 

 

Keyboard  Use your keyboard to perform this function 

 

Ctrl+Key Press Control+Key  simultaneously on your 

Keyboard e.g. Ctrl+Delete 

Menu>Jobs>Delete/Reorder Jobs This means:-  from the menu bar ,Select 

Job>Then Select  the Jobs option> then select 

the Delete/reorder Jobs option 

MLP and S  Materials, Labour Plant and Sub-Contractor 

Resources    Materials, Labour, Plant, Sub-Contractor 

MENU > 

 

Access the command through the menu bar 

Ctrl + Key  

 

Use these keys simultaneously keeping the 

Ctrl Key (or Alt or Shift key depressed whilst 

the other key is depressed. 

RUN:  This means that you should either:- 

 Press your Start Button 

 Select Run 

 Browse and select the appropriate 

drive (e.g. D:\Setup.EXE) or 

 Locate the file referred to using 

Windows Explorer. With the required 

file highlighted, press Return or 

double click the file with your mouse. 

The above for installation purposes only 

RUN  

  

Whilst in the program means that you should 

Run a pre-set menu command from the 

Liberate menu 

<Enter> 

 

 

Press your Enter or Return key 

Underlined text  Refer to more detailed help elsewhere in 

the manual on the underlined subject 
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CUSTOM VIEWS 

This feature allows you to reorder any of the grids and see information most useful to you at the 

time. It also applies to the forms from which you are selecting or changing jobs and the library 

forms 

 

You can set up custom views on all of the screens using the procedures below 

 

Procedure to reorder the grids 

1. Place your mouse onto the column heading 

2. Click and hold your left mouse key 

3. Drag the heading to the desired position 

 

Procedure to make the columns wider or narrower 

1. Place your mouse cursor at the top of the screen over the column headings 

2. As the cursor passes over the divider line the cursor will change to <II> 

3. At this point, drag the column widths. 

 

You can view the screens with or without colours 

Menu>File>Options>Select the Colour coding check box 

 

On the Items screen you can set the horizontal and vertical splitter bars to allow more space/less 

space for the resource screens 

You can widen or make narrower the Items grid and description box 

 

To change these views move your mouse slowly over the sections that divide the various parts of 

the screens. When your cursor changes to <II> or =^=, drag the splitter bar to the required position.  

 

You can reset the views to Liberate defaults using Menu>View>Default layout 
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WHAT TO DO IF… 

A Job is not visible to you. 

 Your user level may be below the level for that Job. Reset the user level of the Job or request 

the user with access to that Job to reset the user level to your level 

 

Your screens are larger than your computer screen and you have to use scroll bars to see the 

Liberate Screens. 

 Reset your screen resolution to 800 x 600 minimum. This can be done in control panel or 

by right clicking on your desktop and selecting properties. 

 

You cannot find where you stored calculations on a take-off pad 

 Preview or print the report that provides this information 

 

You imported a Job but the resources do not have a Y set against them 

 These resources are not found in your library in the same format as the library from which 

you exported the Job. 

 You can save each individual resource to your library 

 

You have changed details of a resource in the resource library but the details of that resource have 

not updated in your Job 

 Run Connect from the Library Menu to update the current Job only 

 

You don’t like the order of the grids on any forms 

 Reorder the grids using your mouse. Set up the title positions and the widths  

 

There is a difference shown in the difference box on the Job screen 

 Increase the decimal places of the Money Using File>Options>Money Tab until the 

difference is minimised 

 

You see that the Total as shown on in the resource totals box on top of the items screen is different 

from the total in the Totals field for that resource. 

 Increase the decimal places as above 

 

You want to display the currency symbol 

Set the currency symbol in the options box. The default setting as taken from your Control panel 

International settings is displayed 

 

You need to rearrange the order of records on the Job list 

 Use the reorder function from the Job screen Job menu 

 

You need to rearrange the order of records on the Items list 

 Use the  vertical arrows at the bottom of the Items or resource screens 

 

You need to rearrange the order of records on any resource section 

 Use the  vertical arrows at the bottom of the Items or resource screens 

 

You saved an Item to the items library but can't remember under which category you saved it. 

 Use different search filters. Try searching by description. And enter any Keyword that may 

be in the description line for that item 

 The forms all seem too big for the screen 

 Your screen resolution is set to less than 600 x 800. Set your screen to 600 x 800 using your 

right mouse from your desk top or from control panel 
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You want to navigate back to the description on the Items screen without using your mouse: 

 Alt+D 

 

You wish to mass delete a list of resources from the library. 

 From Admin> Resource Library: Search the library by Category or by Supplier. Hold down 

your Ctrl+Delete Key and the list will delete record by record. It is fast though. 

 

 

 

SAVING 

YOUR LAST ENTRY OR EDIT IS NOT SAVED AUTOMATICALLY.  

 

 Newly created records are automatically saved on creation of the next record. (A record is any 

new line of information on any screen.) 

 If you wish your information to update before you create the new record press Ctrl + S 

 If you wish information to update immediately press Ctrl +S 

 In order to save the last record press Ctrl + S 

 Each time you create a new record, the previous record is automatically saved. 
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THE JOB SCREEN 

This is the information screen that is displayed on entering the system and contains information 

about the current active Job 

 Select Alt+I or the I icon to see the items that make up this Job 

 

 Change to or create another Job using the Menu>JOB from this screen 

 

 

 

Parts of the Job Screen 

This screen provides you with information about the current selected Job.  

 

The Icon Toolbar and Menu.  

Allowing your mouse pointer to rest over an Icon will bring up a description of the Icons function. 

Further information is simultaneously displayed on the status bar at the bottom of your screen 

Menu functions may be accessed through the keyboard by pressing ALT+UNDERLINED LETTER e.g. 

ALT+F will open the File menu. 

 

(Most other Job screen functions are accessed from the Menu under the Job section Menu 

function. See below for further information.) 
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Description of Job Screen Components 

 

THE JOB DESCRIPTION BOX 
This shows the active and currently selected Job 

 

JOB DETAILS 
The Details shown relate to the selected Job only. 

 

Start Date and End Date 

This is user driven information that may be used as reminders or tracking information 

 

THE DEFAULT LABOUR RATE 
The value that is set in this box is the labour cost per hour that will be brought down by default 

into each new labour record. See detailed notes in the Labour and Labour Library sections of this 

manual 

 

HOURS /DAY 
The figure that is set in this box will have an impact on the total Man Days report Box on the Job 

Screen. The Hours per day can be changed to accommodate for travelling time or seasonal work. 

 

THE MARK-UP % BOXES 
Tab or mouse click to the boxes on the Left hand half of your screen 

Set a value in each of these boxes 

You can set multiple decimal places to fine tune your final sum 

If there is not a value in the box the value will be 0% 

 

OVERHEAD 
Adds overhead as a % of resources cost 

Resources in your job that are individually marked up are excluded from overhead. You should 

make any adjustments as necessary to cover these excluded items 

 

Example 

If a value of 30 is placed in your labour mark-up box (i.e. you wish to mark up the labour in your 

Job by 30 %) 

All labour resources in the job EXCEPT those flagged individually for item mark up or provisional 

sums will be subjected to the following: 

 

Labour Resource Totals +   ( 30  X  Resource Totals) 

         100 

or 

 

Resource Totals X 1.30 

 

MCDISC% 
Main contractors Discount % 

This allows for main contractors discount. It adds on a specified amount that will later be deducted 

as a discount 

 

Comments 

Type in any comments you wish regarding this Job 
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JOB TOTALS 
Cost 

The cost of all the resource types in this Job  

 

MkUp% 

The average percentage mark-up on this resource type. This may influenced if you have 

individually set some resource types as provisional sums or flagged a resource for Item mark up. 

Please see detailed information on these features 

There is a report that allows you to analyse these details 

 

Profit  

This shows you the profit that you are making on this Job 

 

Sell 

The Cost plus the profit 

 

RESOURCE TOTALS 
This shows the total cost and marked up value of the resources in your Job 

 

PROVISIONAL SUMS 
Resources flagged in the Item resource screens for "None" mark-up are classified as Provisional 

sums. These are not subjected to mark-up or discount and are added on with their nett values a 

collection of all of the Provisional sums in your Job 

 

Total 

Costs + Provisional sums 

Sell + provisional sums 

 

With Discount 

If there is a figure in the discount box (MCDisc %) - The Job Value +The discount value of the Job is 

shown in this box. 

 

Items Total 

Liberate calculates in a unique way to allow accuracy for those trades which may be working with 

very high quantities at very low rates. (Grounds maintenance for example) 

This facility allows you to compensate for rounding differences that may occur 

This box reflects the total of the bill of quantities items added together. 

 

There are 2 calculations taking place at any time: 

 

The Materials + Labour + Plant + Sub-Contractor  

 

and  

 

The total of the Items on the Items screen 

 

This system highlights any rounding differences that may be occurring 

 

So let us assume that in a build up  

Quantity = 10000 

Materials = 50.00   Labour  = 600.00  Plant =300.00   
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The Resource Total is 950.00 

 

If the decimal places on money are set in your Options to 1.00, (2 decimal places) 

then your items total will read:- 

 

950.00/10000 =.09 and then .09 X10000 = 900.00 

There is a 50.00 rounding error which is shown in two places 

 

1 The totals box at the top of your items screen will not = the Items total for that item 

2 There will be a difference shown in the Difference box on the Job screen which will include 

the 50.00 rounding errors. (Other rounding errors may compensate for this error) 

3 To correct or compensate simply increase the Decimal places shown under money in your  

Options Menu (File >Options) to an amount which minimises the difference. 

 

DIFFERENCE 
This box reflects the difference described in the section above titled Items Total. The value in 

this box should be as low as possible. Adjust this value by increasing the number of decimal 

places under Money in the Options box. 

To correct or compensate simply increases the Decimal places shown under money to an 

amount which minimises the difference. 

 

DEFAULT LABOUR RATE 
1. The default labour rate is the rate that is used whenever you create a new labour record. 

2. Every labour record must have a default labour rate or a library labour rate. 

3. The default labour rate is set in on the Job screen 

4. When you change this value on the Job screen all of your labour items using the default labour 

rate will update to the new default labour rate. 

5. The default labour rate shows up as (Job) in the code column of the labour Resource 

6. screen. 

7. Any other labour rate will show up with its library code. 

8. You therefore have a reference on every rate used. 

 

If you prefer to set Days instead of Hours as your default labour Rate 

Set your day rate in the Default labour rate box on the Job screen 

Set the Hours per day value to 1 

The unit on your Job screen will still read hours but the man-day count will be correct. 

 

Using the Labour Library 

See Labour resource library 

 

 

OTHER FUNCTIONS ACCESSED FROM THE JOB SCREEN 

CREATE NEW EMPTY JOB  
1. On the Job screen 

2. Menu>Job>Create new empty Job 

3. Choose A Normal Job (see below for Master Jobs) 

4. Press finish 

5. Place a title in the description box and your mark-ups /labour rates etc by pressing buttons 

1,2,3 and begin work on the new Job 

6. Note: Your default labour rate may be set up Via the Options button accessed from the Job 

screen. 
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MASTER JOBS AND SUB JOBS 

A master job is simply a file which holds a number of sub–jobs. The reports produced by 

the master job enable you to see the resources for a number of jobs together or issue a 

B/Q of a number of collated sub-jobs. 

 

1. Create your sub jobs and then create a new Master Job 

2. Sub Jobs e.g. Preliminaries, Earthworks, Concrete, Brickwork, Soft Landscape etc 

or 

3. All jobs currently out on tender  ( so that you can assess your workload ) 

or  

4. All won jobs for the next month. ( so that you can assess your Material , Labour, Plant 

requirements for next month) 

 

5. You can then run reports to ascertain your total requirement on say bricks or labour or 

hired plant for the period chosen. 

 

6. Please note that you cannot alter information in a master job. You have to open the sub 

job to alter or amend information. 

 

7. We strongly suggest that if after making alterations you wish to refresh the master job 

that you use the Refresh Master Job function found on the Job menu under File in the 

master Job. 

 

Procedure for creating a Master Job 

 

On the Job screen:- 

1. Menu>Job>Create new empty Job 

2. Choose A Master Job (see below for Master Jobs) 

3. Press finish 

4. Place a title in the description box and your mark-ups /labour rates etc by pressing button 

1. 

5. Now simply add the sub jobs to the master Job by pressing the “3” button and “Add” 

6. The sub jobs will be added in the order you select them. 

7. You can change the order of the sub jobs by using the yellow up/down reorder arrows 

whilst in the “Change” Jobs dialogue (button no 3) 

8. It may be useful to note that a sub job can be part of more than one Master Job scenarios  
 

 

 

RE-ORDER JOBS 
You may have a high number of Jobs on your Job list and wish to see those with a higher priority 

or in a different order on the list 

 

Procedure 

Select Menu>Job>Delete/Reorder Jobs 

1. If the screen is not maximised it use the Maximise button at the top right of the screen 

2. You can then see information about each Job which will allow you to select the Job or Jobs 

you require effectively See also Custom views 

3. On the Delete/Re-order Jobs screen a grid is shown. Information provides is as follows: 

 Description 

 Level 

 Start date 
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 End date 

 Comment Created on 

 Created by 

 Last modified on 

 Last modified by 

 

4. You can set up this grid in terms of grid width and column position by dragging the column 

widths or reordering the column titles at the top of the screen. 

5. Use the blue vertical arrows in the bottom right of the screen to move a selected Job to a 

higher or lower place on the Job list. 

6. Press Ctrl+J or the J button to return to the Jobs screen 

 

 

CREATE A DUPLICATE JOB 
You can copy an existing Job and make a duplicate of it.  

This allows you to leave your original estimate intact and make any changes in the new copy 

 

Procedure 

From the Job screen 

1. Menu>Job>Create Duplicate Job 

2. Select the Job you want to duplicate (see also Custom views) 

3. You can view more lines of text by selecting the Double Height button on the bottom right 

of the screen 

4. You can see more of the details of the original Job by sizing the columns  or reordering the 

columns of the grid on the Choose a Job screen   See Custom Set-up 

5. You can see more of the details of the original Job by sizing the columns  or reordering the 

columns of the grid on the Choose a Job screen   See Custom Set-up 

6. Double click or press OK 

7. You will be prompted to rename the Job 

8. Rename the New Job in the Description Box. 

 
 

DELETE JOBS 
Deleting cannot be undone. We recommend you Export to a backup before deleting Jobs 

 

Procedure 

From the Job screen 

Menu>Job>Delete/Reorder Jobs 

1. Select the Job or Jobs you want to delete 

2. You can view more lines of text by selecting the Double Height button on the bottom right of 

the screen 

3. You can see more of the details of the original Job by sizing the columns or reordering the 

columns of the grid on the Choose a Job screen   See Custom Set-up 

 Description 

 Level 

 Start date 

 End date 

 Comment Created on 

 Created by 

 Last modified on 

 Last modified by 
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4. Double click or press OK 

5. You will be prompted to confirm the delete 

6. Press Ctrl+J to return to the Job Screen 

 

JOB MARK-UP 
1. Job Mark-up refers to overall mark-ups as set in on the Job screen 

2. Items are marked up by the percentage as set in on the Job screen in the Mark-up 

box. 

3. You must set a percentage against each resource on the Job screen. Leaving the 

box blank will default that resource to a 0% mark-up.  

4. Items can also be marked up individually at Item level. Any item that is individually 

marked up is excluded at resource level from the Job mark-up. 

5. If an Items resources are individually marked up, only those items are excluded 

from the Job mark-up. 

 

Please see the Notes in the Items screen section for Item Mark-up 

You can get an analysis of this by printing the report titled Item mark-up. 

 

 

MAN-HOURS AND MAN-DAYS 
A man-day is a collection of man-hours 

The amount of man-hours in a man-day is dependent on the Hours per day you have set in on your 

Job screen. 

This is a useful tool for evaluating how long a Job will take to do.  

The figure shown in the man-days box on the Job screen in inversely proportional to the Hours/day. 

As the  amount of hours in a day increases the man-days for the Job or the Item will decrease 

The man-hours are the amount of hours x the number of men  

 

Man-hours are shown at the Resource level e.g. 2 men for 3 hours = 6 man-hours 

 

Man-days are shown at: 

The Items level: This collates all of the man-hours on the labour resource screen for that Item and 

shows the total amount of man-days 

The Job level: This collates all of the man-days in the individual Items and shows the total man-

days for the Job. 

 

Example 

You have a Job where you have set in the amount of hours per day at 8 hours. 

The Total man-days reported on the Job screen is 100 days (800 hours based on all of the individual 

labour resource hours. 

Due to a change in programme of the Job you will now be doing the Job in Winter where there are 

fewer working hours in the day. 

Change the Hours/Day to 6.5 (and press Ctrl+S) to save the change 

The Total man-days will now report 123.08 days (800/6.5) 

 

Note  

If you prefer to work in Days rather than hours:  

On your Items screen to can set the Default labour rate to a day rate 

Set the hours per day to 1 

The labour resource screen will still report the unit as hours however, but the unit at Items and 

Job level will be correct. 
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BACKING UP YOUR DATA 

 

IMPORT AND EXPORT YOUR JOBS DATA 

BACKUP DATABASES 

DATABASE MAINTENANCE 
 

Please note on the personal edition your data is held in two folder called Jobs and Library 

• The Databases are installed to the folder C:\Users\user_name\AppData\Roaming\Liberate 

(you cannot vary this) 

• Liberate must be closed when you move or back up this data 

• If you are moving your data from Personal to Multiuser, this is the only data you require once 

you have completed the installation 

 

You can use Import and Export to move Any Job, a selection of Jobs or all Jobs to a backup file for 

safe storage or to Import the Job or Jobs onto another computer. 

We strongly suggest that you backup regularly especially whilst working on large projects to 

safeguard your work and prevent loss of data from possible file corruption or hard disk failure. 

 

Method 1  

Using the Liberate Internal Backup System. 

This will back up your Jobs and remove any errors from your files. This is the safest backup 

system. It will not backup your library. Use method 2 below for Library backup 

 

On the Job Screen /Job>Export Jobs or Export All Jobs 

 

Export Jobs 

You can export One or Many Jobs in a particular folder - You cannot export many jobs in different 

folders. 

 

Export All Jobs 

Exports all jobs on you current system (You lose your folder structure in the back up file but all 

jobs are backed up) 

 

Backing up does not modify any of your data in your databases – It just makes copies 

 

To Export specific Jobs or Jobs in a single folder 

1. From the Job Screen/ Menu/ Job: Select Export Jobs  

2. Choose the Job or Jobs that you wish to export. 

3. A dialogue will appear prompting you to name a file 

4. Type a file name in the name box. (example:-14February  or JobName) 

5. Select a location for the export. (My Documents or Desktop etc.) 

6. Press Save 

7. Your Job(s) will be exported to a new file with the name that you selected and an lji extension 

e.g. 14Feb.lji 

8. You can also export directly to a memory stick the Save In box at the top of the Export file 

dialogue and specifying the USB or drive with your memory stick as the location for saving 

your file. 

 

To Export all of your Jobs 

Note: This operation will back up to a single file. The file will not preserve the folder structure as 

existing in Liberate. 
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You will not lose or alter the information in Liberate but when you do re-import the Jobs they will 

all be in one folder. 

 

Procedure 

1. From the Job Screen/ Menu/ Job: Select Export All Jobs  

2. Proceed as per items 2-8 above 

  

To Import Jobs  

1. You can Import from a back-up (Export file) on your local drive, CD or a backup on a 

network 

2. You can Import from a CD or memory stick. 

3. You can import from another machine on the network. 

4. We always recommend that you create a new folder for your imported jobs. You can then 

use the Jobs Organiser to re-order your imported jobs. 

5. When importing you will be given an opportunity on the Import dialogue to create a new 

folder. 

6. When importing Jobs from other Liberate installations you may get error messages ( see 

Sharing files with other users and Jobs Mismatch below 

 

Notes 

1. Imported Jobs are automatically connected to your library unless the Jobs were created 

on a different Liberate Installation 

2. Liberate will check to see if the resources in each job are found in the library with the 

same identifier as the source library of the Job. 

3. If the identical item is found the resources will connect to the library. 

4. If the Job cannot find the exact correct library items that were used originally it will 

notify you when you initially import the job. (See Jobs Mismatch) below 

 

7. It will also notify you when you open the Job and go to your Item screen and run connect 

And then the following dialog boxes reporting this will appear -See below. 

5. At this point you can run the connect function from the menu to reconnect the Job the 

Item, or the Resource back to the library. 

6. If you connect to a library and the resource is priced a different price in the new library 

from the original library, the value of your Job may change. 

7. You can duplicate a job on your system using duplicate functions in Liberate and then 

compare the connected Job to the disconnected Job 

8. You will receive a report of which resources have not managed to connect. At the end of 

the import you will receive a report which tells you which of the resources in the imported 

Jobs were not found in the library. This information can be successively copied to the 

clipboard. See below 

 

If you have exported your Job from one machine and are importing it to another machine the only 

way you can connect is if the libraries on both machines are the same. There is no way within 

Liberate of copying libraries. You must use Windows File copy functions for this.  

You may however copy one computers library database to a second computer. 

Be careful. You will overwrite all existing information in that machines library. Please call us for 

advice. 

 

Method for Importing previously backed up Liberate Jobs 

1. From the Job Screen: Select Import  
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2. Use the "Look in" dropdown box to go to the location of your previously exported files or 

you’re a drive or the drive on your network which contains the exported file 

3. A dialogue will appear prompting you to select a lji file from the list. 

4. Select a file name in the name box. (example:-14February.lji  or JobName.lji) 

5. Press Open 

6. A dialogue will appear showing you which jobs are contained in the backup file. You cannot 

choose one or many from the list. The whole list of Jobs will import 

7. You can create a new folder to import the Jobs to and then use Jobs/ Jobs organiser to move/ 

delete jobs. 

8. The Jobs will be imported and you can access your revised list of Jobs through 

Menu>Job>Open Job.  

9. Your Job(s) will be imported and appended at the bottom of the list of existing Jobs on your 

system. 

10. The date of the import will appear alongside the imported file for reference. 

11. Imported files will not overwrite existing Jobs with the same name. 

12. On opening an imported file you must run the Connect function on the items menu if you want 

to update any resource price changes in the Job.  

13. Note: Library functions may not be available to you until the connect function is resolved. 

14. You can reorder the grid on the Select Job screen which shows your Jobs by dragging the titles 

15. You can size each individual column by dragging the width of the column at the vertical line 

which separates the titles of the individual columns. 

 
METHOD 2 - USING MY COMPUTER  

BACKUP YOUR DATA FILES – THIS IS IMPORTANT. DO IT REGULARLY 
 

• Backup your Jobs and Library regularly using Windows File Explorer.  Simply make a copy 

of the folders on another drive or a CD. This method takes you entire Jobs and Library 

databases as they are at the time and allows you to store them. 

• The easiest way is simply to make a copy of the folders below and store them in a separate 

directory. 

Liberate must be closed when you do this. 

 

RESTORING OLD DATABASES FROM A SERVER. 
1. Replace the Jobs and Library folder in the locations as shown above but this will 

overwrite and your will lose your existing data. 

2. Liberate will only read folders calls “Jobs” and “Library” 

3. If you wish to temporally restore an old back-up, rename your current folders to (for 

example) Jobs 1 and Library 1. They then become invisible to Liberate. 

4. Paste the old Jobs and Library 

5. Get the information you require and export it using the Liberate internal Export Jobs 

functions. 

6. Restore the current data folders by renaming them back to Jobs and Library 

respectively. You will also have to rename or remove the recently restored data files. 

7. Import the exported data into your current file list. 

 

Liberate must be closed when you do this 
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FILE LOCATIONS 

Personal Edition 

• The program is installed by default to the C:\Program files\ or (Program files X86) 

directory (You can vary this) 

• The Databases are installed to the folder 

C:\Users\user_name\AppData\Roaming\Liberate (you cannot vary this) 

• Note- This is a hidden directory and you would need to Use >Windows View 

Options>Show hidden files and folders. 

• Please ensure you back up the Jobs and Library folders found as above - regularly 

• The licence is installed to the directory C:\ProgramData\JR  

 

Multi-user Edition 

The path to the databases is user selected and may have been renamed from the defaults 

on installation 

 

The default path for the data files is either:  

\Server Name\ Liberate \LibV4MUS\Library 

\Server Name\Program files\LibV4MUS\Jobs 

 

It is highly likely that on installation you changed the default location so:- 

 

If you are not sure where the server files are stored, you can see this by starting Liberate 

and looking in Help/ About. 

Press the blue i button and look down the list for these paths. 

 

• See also Import and Export 

• See also Sharing Files with other users  
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SHARING JOBS WITH OTHER USERS 

. 

 

UNDERSTANDING LIBRARY RESOURCES 
• A library resource that is used in a Job has a tick next to it. 

• This library resource is stored as computer code in the library. 

• This means that if you have a computer with a resource Timber 200 x 100 in one library 

and an exact match of this in another library, the two Computers will not have stored 

it with the same address if they were created from different libraries. 

• Once you have told the Computer B that this Timber 200 x 100 is the same Timber 

200 x 100 as used in Computer A it will always remember this.  

 

JOBS MISMATCH 
This is arguably the only slightly complex function in Liberate. Once you have mastered the 

understanding of this you will have no issues importing in the future. 

This function will be improved in the next version of Liberate 

 

If you get the following messages on importing a Job from another installation: 

 

 
 

 

It is worthwhile doing the Full Resolve once.  

If you are continually swapping jobs between PC’s you should eventually have very few 

resources to resolve on subsequent imports. 

Only new library resources that have been created for a particular job that exist in the new 

Job but not in the library on the machine being imported to will need to be saved. 

 

 

• Open your Job 

• Go to the Items screen 

• Run connect from the Chain-link icon or the menu under Library. 
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• The dialogue that appears will show you a list of resources that are in the Job that 

were connected to the original library but are not in the current library. 

You now have 3 options:- 

 

1. Save Selected Resource Type into Resource Library 

• Save the resources selected one at a time to the resource library. – Library 

functions will be enabled at completion.  

2. Disconnect All Remaining Resources 

• Only resources currently common between the Job and the current library 

will be updated – all other resources will be disconnected 

3. Cancel 

• You can continue with your Job but you will have no Library functionality 

 

It is best at this stage to Resolve this by adding this to your library using the Save Selected 

Resource Type into Resource Library. 

 

Please note that you have to do this one resource line at a time. 

 

• Click on each line and choose the Save Selected Resource Type into Resource Library 

button 

• If the library detects a similar resource it will offer you two tabs: Connect to existing 

entry or Save new Entry 

• If you choose connect to existing resource it will Change the resource in the Job to 

the Existing resource in the Library (be careful)  

• Move to the next resource. 

 

Note that it is always a good idea to note the values of the Job before you run connect and 

the Job after you run connect. 

If you are unsure or feel you have made errors, simply reimport the Job from the .lji file 
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You can also choose to Disconnect all Remaining resources but the resources that were in the 

original library will not be in your current library 

 

COPY TO THE CLIPBOARD 
 

When you IMPORT from an EXPORT file you may get a messages alerting you that some resources 

are no longer connected to your library. 

This means that these resources will not automatically update if you change details about them in 

your library and run CONNECT. 

 

Copying this to the clipboard allows you to store this information on a text Excel or Word 

processor file for later use. 

 

The clipboard is essentially your computers short-term memory.   

When you copy to the clipboard you are telling your computer “Remember this for a while, I'm 

going to ask you about it in a few minutes”. 

You ask your computer about what's in its memory by pasting its memory onto your word 

processor or Notepad. 

Every time you copy additional information to the clipboard, the previously copied information is 

overwritten. 

You must therefore Paste (Ctrl+V) the current information into your text document before you 

copy further information to the clipboard. 

 

 

Open Excel WordPad, Notepad or your word processor. 

Use that applications paste functions to paste the clipboard contents. 

You can now copy further information to the clipboard and paste below the information you have 

already pasted. 

If you are familiar with Excels Text to columns functions you can use these. 

 

Remember that any further Copy to Clipboard commands will overwrite the current contents of 

your clipboard. We therefore recommend that you Paste the clipboard immediately if you wish to 

keep a record.  



 

 43 

THE ITEMS SCREEN 

This section contains an initial overview. Detailed explanations follow 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is where all of your Job build-up will take place 

The Item screen consists of 2 basic parts 

 

The Items Screen; This is your Bill of quantities on the top half of the screen and consists of one or 

many Items each with one or many resources 

 

The Resource Screens: The four possible resources that make up any Item.  

Materials 

Labour 

Plant (Machinery) 

Sub-Contractor 

 

These four resources are found in the bottom half of the screen on separate tabs. 

Click a tab to view the contents of the resource screen 

Additionally there is a tab for Item Mark-up. This will exclude the resources selected from any Item 

Mark-up as indicated on the Job screen.  

 

SET UP PREFERENCES 
You may customise your screen using the horizontal and vertical splitter bars under the items 

section. 

You may set up the individual columns on the Items and Resource screens by dragging the column 

headings to the order of your choice. 

See Custom Views 

These set-ups will remain in place until you run Menu >View>Restore Default layout. 

Task description 

Quantities and costs 

Resource Screens 

(Materials only shown here) 

Tabs show Labour Plant and sub-contractor resources  for this item 

Re-order/ bookmark 

Item Mark-up 

Summary boxes for this item 
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NAVIGATION 
F12   to append a new record 

INSERT  to insert 

Ctrl+Delete  to delete a record 

 

 

Use tab or Return  (Enter) to navigate 

Use Alt +D to return you to the Description box 

 

 

BOOKMARKS 
Use the bookmark function at the bottom of the Items section of the Items screen to bookmark 

an Item. 

Once you have book marked an item the Jump to bookmark icon lights and using this you can jump 

from any item to the book marked item 

 

REORDER ITEMS 
Use the vertical arrows at the bottom of the screens to re-order any item or resource. 

 

 

INDIVIDUAL MARK-UPS 
You can set individual mark-ups for this item if you wish to vary the mark-up for this 

Item only. The global mark-up is set in on the Job screen.   

 

SPELL CHECK  
This is found under the Edit menu or Control+ F7 

  



 

 45 

MATERIALS  

Alt+M 

 

 To add materials to your materials list F12 to create a new record 

 Type a description 

 Type a quantity 

 Type a unit 

 Type the default waste 

 Optionally add this new material resource to the materials library F10 

 

 

USING THE MATERIALS LIBRARY 
1. You can retrieve materials directly from the materials library. F9 

2. Type the first few letters of the materials description and press F9 

3. or press F9 to search on a blank description and then use the library filters. 

4. Materials retrieved from the materials library will be linked to your Job from the library. If you update 

details about the material in the library all instances of the material in your Job will update WHEN YOU 

RUN THE CONNECT FUNCTION. 

5. You can see if a material is connected to the library. If it has a Y in the Lib (library) field. having a Y 

would not necessarily mean that the resource has updated only that it has the ability to update if you 

want it to.  

6. If you open older Jobs that used the same material resource, these can optionally be updated to the 

new library details by running CONNECT from the menu 

7. Always run CONNECT before submitting your final quotation 

8. You can enter resources and not save them to the library.  

 

 

Notes 

 Materials are one of four possible resource types in any Item build-up . 

 Once you have created an Item, select the materials screen for that item and input the materials 

required. 

 You can type the required materials directly onto the form, 

 Materials that are retrieved or saved to the library will have a Y symbol in the lib field on the form to 

indicate that they are a library resource. 

 Updating the resource details in the library will update all usage's of that material in your job once you 

have run the Connect function from Menu>Library>Connect and Disconnect 

 You can reorder the materials on the form using the vertical arrows on the bottom of the form. 

 You can assign an item mark-up to all of the materials in an item which will exclude those materials 

from the Job mark up and subject them to your chosen mark-up 

 You can also select No mark-up which will designate the materials as a Provisional sum 

 You can get printed reports of your materials for a Job. 

 The "materials by supplier" report will only show materials that have a supplier name against them 
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LABOUR 

Alt+L 

 

The labour screen works slightly differently to the other resource screens. 

 

Labour must either be a default labour rate record or a library linked labour rate. 

You cannot enter labour rates directly into the labour resource form. 

 

The Two Options 

Labour rates may either be connected to the default rate on the Job Screen and will update when you 

change the default rate on the Job screen. 

If you prefer to use Labour rates from the labour library, are connected to the library rate and will only 

update when you run CONNECT from the Library menu (if you have changed details of a labour resource in 

the labour library. 

 

 To add labour to your labours form F12 to create a new record 

 Type a description 

 Type a quantity for the amount of men to do the task 

 Type a quantity for the number of Hours to do the task 

 

TO USE MINUTES INSTEAD OF HOURS 
Minutes must be expressed as parts of an hour. If for instance you are doing an ITEM build up and you wish 

to calculate for one unit so that the build-up can be saved to the Items library and reused for any number 

of Units in the future: 

 Increase the decimal places for the number and money using the Options menu  

 For 5 minutes: Type in the units as Men [1] - Hours [.0833] 

 

LABOUR RATES AND THE LABOUR LIBRARY 

USING THE LABOUR LIBRARY 
If you do not wish to use the default rate on the Job screen 

You can retrieve labour directly from the labour library. F9 

When you retrieve a Labour rate from the clear but you will see the Unique labour code with a tick 

(✔) next to it. 

Describe the task and continue. – You can use a mix of default and Library labour. 

 

Method 

1. Type the first few letters of the Labour description and press F9. 

2. or press F9 to search on a blank description and then use the library filters in this instance I typed Car 

to search for carpenters. 

 

 
 

3. The resource –Carpenter is retrieved but the Code only and the rate are shown. 

4. I then add the task description to describe the tasks that the carpenter will do. 
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5. In the example below, there is a library carpenter and a default rate assistant. The tasks are clearly 

described for use in works programs or discussion. The hours are fully reported. 

 

 

 
 

Further clarifications 

 

6. Labour retrieved from the Labour library will be linked to your Job from the library. If you update details 

about the labour in the library all instances of the labour in your Job will update WHEN YOU RUN THE 

CONNECT FUNCTION. 

7. You can see if a labour is connected to the library by checking if it has a ✔ in the Lib (library) field. Having a 

Tick would not necessarily mean that the resource has updated only that it has the ability to update if you 

want it to.  

8. Labour resources with a ✔ are from the Labour library; Labour resources showing as Job are from the Job 

screen labour rate. 

9. If you open older Jobs that used the same labour resource, these can optionally be updated to the new 

library details by running CONNECT from the menu 

10. Always run CONNECT before submitting your final quotation 

11. You can enter resources and not save them to the library.  

 

 

Notes 

 Labour are one of four possible resource types in any Item build-up. 

 Once you have created an Item, select the Labour screen for that item and input the Labour required. 

 You can type the required Labour descriptions but not the rates directly onto the form, 

 Labour that is retrieved from the library will have a library code against it in the lib field on the form to 

indicate that that labour resource is a library resource and not a default labour item. The code also 

helps you to identify which labour resource type you have used. 

 Updating the resource details in the library will update all usages of that labour in your job once you 

have run the Connect function from Menu>Library>Connect and Disconnect 

 You can reorder the Labour on the form using the vertical arrows on the bottom of the form. 

 You can assign an item mark-up to all of the Labour in an item which will exclude those Labour from 

the Job mark up and subject them to your chosen mark-up 

 You can also select No mark-up which will designate the Labour as a Provisional sum 

You can get printed reports of your Labour for a Job. 
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PLANT   (MACHINERY) 

Alt+P 

 

 To add Plant to your Plant resource form F12 to create a new record 

 Type a description 

 Type a quantity 

 Type a unit 

 Optionally add this new Plant resource to the Plant resource library F10 

 

 

USING THE PLANT RESOURCE LIBRARY 
1. You can retrieve Plant directly from the Plant resource library. F9 

2. Type the first few letters of the Plant resource description and press F9 

3. or press F9 to search on a blank description and then use the library filters. 

4. Plant retrieved from the Plant library will be linked to your Job from the library. If you update details 

about the Plant resource in the library all instances of the Plant resource in your Job will update WHEN 

YOU RUN THE CONNECT FUNCTION. 

5. You can see if a Plant resource is connected to the library. If it has a Y in the Lib (library) field. having a 

Y would not necessarily mean that the resource has updated only that it has the ability to update if you 

want it to.  

6. If you open older Jobs that used the same Plant resource, these can optionally be updated to the new 

library details by running CONNECT from the menu 

7. Always run CONNECT before submitting your final quotation 

8. You can enter resources and not save them to the library.  

 

 

Notes 

 Plant are one of four possible resource types in any Item build-up. 

 You can type the required Plant directly onto the form, 

 Plant that is retrieved or saved to the library will have a Y symbol in the lib field on the form to indicate 

that they are a library resource. 

 Updating the resource details in the library will update all usage's of that Plant in your job once you 

have run the Connect function from Menu>Library>Connect and Disconnect 

 You can reorder the Plant resource on the form using the vertical arrows on the bottom of the form. 

 You can assign an item mark-up to all of the Plant resource in an item which will exclude those Plant 

resource from the Job mark up and subject them to your chosen mark-up 

 You can also select No mark-up which will designate the Plant as a Provisional sum 

 You can get printed reports of your Plant resources for a Job. 

 

 



 

 

 49 

SUB-CONTRACTOR 

Alt+S 

 

 To add Sub-Contractors to your Sub-Contractors form F12 to create a new record 

 Type a description 

 Type a quantity 

 Type a unit 

 Optionally add this new Sub-Contractor resource to the Sub-Contractors library F10. At the time of 

saving select one of your previously registered sub-contractor suppliers from the drop down list of 

previously registered suppliers 

 

 

USING THE SUB-CONTRACTORS LIBRARY 
1. You can retrieve Sub-Contractors directly from the Sub-Contractors library. F9 

2. Type the first few letters of the Sub-Contractors description and press F9 

3. or press F9 to search on a blank description and then use the library filters. 

4. Sub-Contractors retrieved from the Sub-Contractors library will be linked to your Job from the library. 

If you update details about the Sub-Contractor in the library all instances of the Sub-Contractor in your 

Job will update WHEN YOU RUN THE CONNECT FUNCTION. 

5. You can see if a Sub-Contractor is connected to the library. If it has a Y in the Lib (library) field. having 

a Y would not necessarily mean that the resource has updated only that it has the ability to update if 

you want it to.  

6. If you open older Jobs that used the same Sub-Contractor resource, these can optionally be updated 

to the new library details by running CONNECT from the menu 

7. Always run CONNECT before submitting your final quotation 

8. You can enter resources and not save them to the library.  

 

 

Notes 

 Sub-Contractors are one of four possible resource types in any Item build-up. 

 Once you have created an Item, select the Sub-Contractors screen for that item and input the Sub-

Contractors required. 

 You can type the required Sub-Contractors directly onto the form, 

 Sub-Contractors that are retrieved or saved to the library will have a Y symbol in the lib field on the 

form to indicate that they are a library resource. 

 Updating the resource details in the library will update all usage's of that Sub-Contractor in your job 

once you have run the Connect function from Menu>Library>Connect and Disconnect 

 You can reorder the Sub-Contractors on the form using the vertical arrows on the bottom of the form. 

 You can assign an item mark-up to all of the Sub-Contractors in an item which will exclude those Sub-

Contractors from the Job mark up and subject them to your chosen mark-up 

 You can also select No mark-up which will designate the Sub-Contractors as a Provisional sum 

 You can get printed reports of your Sub-Contractors for a Job. 
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SAVING OR CANCELLING CHANGES 
Save Changes  Press Ctrl+S 

Saves changes to your current record. Information is updated as soon as a save is performed.  

If you wish to view the effects of changes you are making to a record save the changes 

 to update the information 

All information is automatically saved as you create a new record 

 

Cancel Changes  Ctrl+Backspace 

You can cancel any changes made to the record that you are working on. 

Changes are only saved once a new record is created or when you have saved the record using 

Ctrl+S. 

Once a new record has been created you cannot undo the changes. 

To cancel changes to the record you are working on. 

 

IMPORTING A BILL OF QUANTITIES TO THE ITEMS 

 

You can import a Bill of quantities directly to your Liberate Items. This is useful if you receive a 

schedule or Bill of quantities in any electronic format. 

You can also scan a paper bill to an electronic format and then import it to Liberate 

 

NOTES 
• Note the target Bill must be in Excel Format 

• The column order must be in the order specified in the wizard. 

• The wizard will only look at the first sheet in a workbook 

• The wizard will look at the Excel sheet and import all active cells. If any formatting exists 

in the cells it will assume that the cell has data. It is therefore a good idea to delete all 

rows after the required information to be imported otherwise Liberate will look for 

information possibly right up to row 1048000 (the current excel spreadsheet size). This 

can obviously be very time consuming. 

• Excel cells can be active even if there appears to be nothing in them. This is caused by 

number formatting or borders which have not been used and bay have been selected by 

the Excel author. 

• Word tables and scanned documents may be converted to Excel format. Some excel 

knowledge is required. 

• If you don’t have a frequency leave these blank 

 

METHOD OF IMPORT OF B OF Q  
 

1. Create a new Job in Liberate 

2. Ensure that the target Excel sheet is closed 

3. From the Job screen in Liberate select  Import BoQ 

4. Follow the instructions of the wizard 
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THE TAKE OFF PAD    

This feature allows you to record measurements or calculations 

 

 Access the take off pad using the Icon on the tool bar whilst you are on any materials resource 

 The take off pad is available against each record of material resources 

 There is no limit to the amount of pads you can have in an item 

 The pad calculations are stored for future reference 

 You can place comments against any measurement within the pad by using  ! (Exclamation mark) or ; 

(semi colon) to separate the comments from the calculations. 

 You may use brackets as you would in any arithmetical function 

 The total of the pad calculation is reflected in the material quantity field once you close the pad. 

 You can overwrite this total and still retain the total inside the pad itself 

 If you do not have a material resource against the calculation you should simply write a mote to 

yourself against the pad quantity to remind you where the measurement is located. 

 Example: “Volume of new driveway excavation” 

 You can then place a unit but omit the rate. 

 There is also a report to print pad measurements 

 The pad measurement note will also appear in the Items details reports as a material if you have 

labelled it as such. 

 

A typical pad calculation may look like this: 

0.5*10*20 ! Top area 

5+12-(3*1.2) ;Bottom area 

 

Or, for example, if you are doing soil volumes and wish to use a bulking factor of 20% or a waste factor 

 

12*3*1.2 or 12*3*(20/100) is not equal to 12*3*20/100 
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The following operators are supported 

Addition  + 

Subtraction   - 

Multiplication * 

Division \ 

Pi   Pi 
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LIBRARIES OVERVIEW 

 

You have 5 libraries: 

 

1.   A built-up “Items” library 

2.   A Materials library 

3.   A Labour library 

4.   A Plant (machinery) library 

5.   A Sub-Contractors library 

 

Function keys to use: 

 

F10 To save into any library from the items or any resource screen OR use the save to library 

Icon on your toolbar. 

 

F9 To retrieve or lookup from any library from the items screen or any resource screen OR 

use the retrieve to library Icon on your toolbar. Note that you will always be taken into the library 

for whichever screen you are currently in, for example: 

F9 from the Materials screen will automatically look up the Materials library;  

F9 from the Items screen will automatically look up built-up Items in the Items Library; 

Etc. To amend and update the libraries use Admin and choose the appropriate library  

 

See detailed descriptions below 

 

 

THE ITEMS LIBRARY 

Your cursor must be on the Items section of the screen to access the Items library. If your cursor is on 

a resource screen pressing F9 or F10 will access the resource library of the resource type that is active. 

To save a built-up item to the items library press F10 

To select a built-up item from the items library press F9 

 

SAVING BUILT UP ITEMS TO THE ITEMS LIBRARY: 
1. Whilst on the Items screen and on the item that you wish to store to the library: 

2. Press F10 (or select Menu>Library>Save to Library) 

3. A dialogue box appears with the details of the description, the Rate, The Original Job and The date. 

4. You now select a category using the drop down box and selecting the First letter ( then the second 

letter and so on until the desired category is located) of the required category - or 

5. You scroll down through the available categories: or 

6. You add a new category 

7. Press the Save to Library button 
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SELECT ITEMS FROM THE ITEMS LIBRARY 
 

To select a previously stored Item from the Items Library into your Job 

(NB. You can set up the screen so that you can see the columns in any width or any order - please see 

Custom Views).  

 

1. Whilst on the Items screen: Press F9 (or Menu Library>Select from Library) 

2. Use the filter(s) - single or a combination - at the bottom of the screen to find the item you are looking 

for as follows: 

a. The category:  

Type the first letter e.g. B (for Brick Paving). If you are then faced with too many categories starting 

with B, type the 2nd letter to narrow down the search and so on. 

Select the category required and the items in that category only will show. 

b. The Original Job 

You can also search by “The original job”. The original Job information is automatically stored to 

the library when you store the Item 

c. Code 

If you have given the Item a code you can use this to search. 

d. Description 

You can also search by description by typing a key word that may be contained in the description 

of the required item. The keyword can be anywhere in the Item description and need not 

necessarily be at the beginning of the description. 

Filters can be saved and used again for further selections. 

3. Multiple selections can be made 

4. Once you have a selection you may use the double or triple height feature to see more of the text for 

that item 

5. Once you have decided which item you wish to use press Retrieve into Job Button. 

6. You will be shown the original quantity and be prompted for the new quantity 

7. Press OK 

8. The new item may now be amended with a more appropriate description and individual resource 

quantities edited. 

9. If the resource exists in the Resource Library the resources will be updated with the current value of 

the resource. 

10. The labour rate will reflect the current default labour rate. 

Labour library resources will be shown as the current rate as contained in the current labour resource 

library for that labour code. If a resource has been used to build the item that was previously found in the 

resource library, and is no longer present in the resource library, you will get a message concerning the 



 

 

 55 

status of this item or items. You can copy this to the clipboard and paste this information to Notepad 

/WordPad /Your word processor etc.  

 

ITEMS LIBRARY CATEGORIES 
1. Create categories to save your library items to using the Menu >Admin>Item Library. 

2. Once in the Item library you may create additional categories using Menu>Record>Show 

Categories(F7) 

3. From here you may Add, Delete or Edit Category names. 

4. You can also create a category at the time of saving the built-up item to the item library by typing in 

the category name in the blank field on the drop down box. 

 

 

MAINTAINING THE ITEMS LIBRARY 

You can access the Items Library for maintenance and this can be done as a separate function to a costing 

exercise (i.e. an administrator can be updating libraries whilst estimators work on quotes).This is done 

through >Menu>Admin> Items Library 

You have access to, and can amend, the description, category,,  original job, code and unit – you cannot 

alter resource details. 

To view the resource details use F6. 

 

If you want to alter the resource details of an Item Library record: 

1. Retrieve the item into a Job 

2. Amend the details 

3. Re-save the Item to the Item library 

Delete the original from the Item Library (Ctrl+DELETE) whilst in the Item Library Maintenance form which 

you will access again via ADMIN>ITEM LIBRARY and then perform a category search 

 

THE RESOURCE LIBRARY  

OVERVIEW 

ACCESS 
 

a. F9  F10  and Menu>Library>Select from Library or Save to Library will access the Resource Library 

if you are a resource screen. 

b. If you are on the Items screen these keys and menu commands will act on the Items Library 

c. Updating the resource library has the option of updating your current Job. You must run Connect 

to complete the process. Liberate has been designed in this way because we assume that when 

you change resource details in the library, these resources may have been used in Jobs that have 

already been submitted and where updating is not permitted. 

d. Updating is therefore only performed when the Connect function is performed 

e. Menu>Library>Connect 

 

Overview 

The resource library consists of four separate libraries namely 

 Materials 

 Labour 

 Plant   

 Sub-Contractor 

 

3 WAYS TO ACCESS THE RESOURCE LIBRARY FOR EACH RESOURCE 
1. To select resources  F9 From a resource screen 
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2. To save resources  F10 From a resource screen 

3. To maintain the library.  Add Delete or change resource details 

 

GENERAL NOTES 

1. Unlike many other estimating systems, resources do not have to exist in the library for you to use 

them in your build-up. You have the option of typing the resource directly into your build-up and 

saving the resource to the library from there. 

2. Except for labour resources, you can also type resources into your build-up without saving them 

to the library at all. Labour Resources must either come from the default labour rate on the Job 

screen or from the labour library if you do not wish to use the default labour rate  

3. You must be on a resource screen to save and retrieve resources from and to any Item in your Job 

4. F9 Accesses a resource library to retrieve information 

5. F10 Accesses a resource library to save information 

6. You can also access the resource libraries through the Menu >Admin>Resource Library. This mode 

of access is for inputting information which is not emanating directly from the Job at build up 

stage. 

7. Resources which exist in a resource library will optionally update the Item. This means that if for 

example you created a bid and then some time later received information about a price being 

updated by one of your suppliers. Obviously you would wish to have the current price in your 

library. 

8. Any Jobs resource values will only be updated if you run the Connect  function to update the Job. 

This means that you can keep a submitted bid intact should you not have the option to submit 

updated prices since submitting the original bid. 

9. You can adjust the values of a selection of resources in the library.  

 

 

 

HOW TO USE THE RESOURCE LIBRARY 

 

There are two library forms. They look almost exactly the same but: 

 The Admin Library form:  Allows you to input and edit each of the libraries only. 

 The Select and Save to Library Forms: Allow you to select and save to the libraries from any of 

your resource screens and has buttons at the bottom of the form. This form is only accessed from 

one of the resource screens. 

 

SAVING RESOURCES TO THE RESOURCE LIBRARY 

 

You can save to the resource library as part of library administration 

(Menu>Library>Admin>Resource Library 

 

You can also save to the resource library directly from your build-up. 

 

1. Whilst on any resource screen 

2. Create a new record F12 

3. Type the description of the resource as you would like it to appear on your build-up, in the library and 

on your reports. e.g. Excavator 3 ton Hitachi 

4. Press return and enter the Quantity, the Unit and the Rate 

5. Double click the comment to enter a comment about the resource though this will not be saved to the 

resource library. 

6. Press F10 

7. A form will appear showing the details which have been taken from your resource form 

8. Select a code if you wish 
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9. Select a category using the drop down box and typing the first few letters of the category you require 

or scroll down to the required category. 

10. Add a new category if the required category does not yet exist 

11. Select or add a Supplier as per the category selection above. 

12. Press the Save to Library button. 

13. The resource will now show a Y in the Lib field of your resource screen to indicate to you that it is 

connected to the library. 

 

IMPORTING ELECTRONIC LIST INTO THE MATERIALS LIBRARY 
 

A Materials list on an MS Excel spreadsheet can be imported into the Materials Library. From the upper 

menu select >Record>Import List to start the import wizard. The data in the spreadsheet must be held in 

strict column order (and with no header row) as specified below: 

 

Column  Data 

A   Description 

B  Code 

C  Unit 

D  Rate 

E  Pack size   

 

You will be invited to specify the Category and Supplier for the data. If these are left blank the data will 

simply be added into the library even when similar data is already present. However if the wizard finds an 

exact match of Description, Code, Category and Supplier in the library then these matched records will be 

updated. Note that discount and waste percentages are not overwritten by the update. 

All records have a date stamp indicating when they were created and last modified. Note that the creation 

date will be the date of upgrade from Liberate Edition 2 to Edition 3 and NOT the date of entry into the 

Edition 2 library. 

 

From this dialog box you will be asked to select a supplier and a category. 

Unlike saving from the Items screen you cannot create categories and suppliers here. These must be pre-

created at from the Library Admin menu as follows 

Supplier : Library admin> View > Suppliers 

Category: Library admin> Record> Categories 

 

 

If these items did not exist previously they will now appear on the drop down list. 

 

 

Tip 

Take some time to organise your descriptions on the spreadsheet  

Example 

If you have received a supplier list as such. 

 

X4z16P 150 x 50 

 

You may wish to amend this to something a bit more friendly such as  

Timber prepared 150 x 25 

You can use the code in the code column for searches and automatic updates of your materials lists 

 

Notes on Electronic Import 

Liberate will only find information in the front Excel tab 

Liberate will only look in the columns shown above 
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Liberate will not recognise any characters in the numeric (quantity or price columns except numbers and 

decimal points 

 

 

Notes 

In order to prevent duplication,  you cannot save the exact same resource to the library twice. You will get 

an error message warning that this is being attempted. 

You can create an identical resource and save it to the library once the resource has been disconnected 

first. The library will tell you that a resource of that name already exists and give you options to connect to 

the original resource or save as a new resource. You can choose to Include Near Matches for the description 

of the resource. 

Choose the appropriate option. You may wish to have the same resource in the library at different prices 

or with minor variations. 

 

SELECTING RESOURCES FROM THE RESOURCE LIBRARY 

 

There are a few ways to query the resource library and to find and select resources to build up an 

Item 

 

Default Description search 

1. Whilst on any resource screen 

2. Create a new record F12 

3. Type the first few letters of the resource  e.g. Br (for bricks) and press F9 

4. A list of all your resources starting with Br will appear 

5. Select one or many of the resources from the list with your mouse or cursor keys and spacebar 

6. Press the retrieve into Job Button 

7. The resources will be brought into the active resource screen 

8. Add a quantity for each resource 

 

You can also search without first typing the first letters into the description field 

1. Whilst on any resource screen 

2. Create a new record F12 

3. Press F9 to access the resource library 

4. Search using the filters – combinations can be used - at the bottom left of the resource library 

screen. 

5. To clear a Filter use the dropdown in “1 Filter” and select <All Records>> or simply delete the 

text previously input into the box for Description, Code, etc. 

 

Description search 

Type some characters of the resources description 

 

Code search 

Type a known code. This is for often used for resources where you find it useful to remember or 

place a code against each resource 

 

Category search 

The category box activates with a drop down arrow.  

Scroll down or type the first letters (and second and third if necessary of the required category.  

Select the required category.  

Resources previously stored under the selected category only will be displayed. 
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Supplier search 

As for category but select the supplier filter button 

 

In all cases where a resource has been used from the library the letter Y will be displayed in the 

Lib field to show you that the resource is a library resource. 

 

If you adjust the price of a resource in the library the price will update when you run connect. 

 

 

THE LABOUR RESOURCE LIBRARY 

The workings of the Labour resource library are slightly different from those of the other resource libraries 

 

 The labour resource library allows you to use library labour rates rather than the default labour 

rate as set in on the Job screen. 

 Every labour library record must have a code set in, in the library 

 The code that is inserted in the record in the Code field will indicate to you which library resource 

you have used. 

 

 Press F9 to retrieve Labour from the Labour resource library. If you have a description in the 

description box the your search will be based on the description 

 If the description field is blank when you press F9 you will access the entire labour library. 

 Select one or many of the labour resources from the library 

 Add the description and quantities in the normal way 

 Run Connect if you have made any changes to the resource library 

 

See detailed notes in the Items Screen section for Labour: 

 

 

MATERIALS RESOURCE LIBRARY 

 

Whilst on a materials resource screen: 

 press F9 to retrieve materials from the materials resource library 

 press F10 to save materials from the materials resource library 

See detailed notes: Items Screen – Materials 

 

 

PLANT RESOURCE LIBRARY 

 

Whilst on a Plant resource screen: 

 press F9 to retrieve Plant from the Plant resource library 

 press F10 to save Plant from the Plant resource library 

 

 

See detailed notes: Items Screen - Plant 

 

SUB-CONTRACTOR RESOURCE LIBRARY 

Whilst on a Sub-Contractor resource screen: 

 press F9 to retrieve Sub-Contractor from the Sub-Contractor resource library 

 press F10 to save Sub-Contractor from the Sub-Contractor resource library 

 

See detailed notes: Items Screen – Sub-Contractor
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CONNECT AND DISCONNECT 

(For ensuring that the resources of your Job match those in the Various resource libraries) 

 

Menu>Library>Connect 

When you retrieve or save resources to a resource library the resources used in your Job remain connected 

to your Job (indicated by the Y in the lib column of your resource screen) 

Any change to the description or price details in the resource library will update all occurrences of that 

resource in your Job – Only when you run the CONNECT Function 

 

 

OPENING A JOB FROM YOUR JOB LIST 

Liberate assumes that Jobs in your job list may have already been submitted and that any changes you 

make to the resource library may not be admissible in already submitted Job. 

 

If you want any resource library changes to take effect, Run connect to update the resources 

 

In all cases you can run connect on the levels as shown in the menu 

 

Connect  Current Job 

  Current Item 

  Current Resource 

  All Materials, or Labour or Plant or Sub-Contractor 

 

You can also disconnect a resource if you do not want it to update 

For full notes on this see Sharing Jobs with other users above 

RESOURCE LIBRARY MAINTENANCE 

 

You can save into and retrieve from the libraries directly from your Job. Resources that have a “Y” 

in the Lib column cannot be edited except by administrating the Library. Changes only take effect 

when you run  ‘Connect’ 

 Maintaining the Resource library is done via Admin on the Menu 

 From there choose the resource library that you wish to work on 

 From there you can perform the following functions 

 

1. Set up a list of your most commonly used Resource Categories in each resource section. 

ADMIN>RESOURCE LIBRARY> Choice of Library>Resource. You can also create new 

resource categories when you save a resource to a library from a resource screen using 

the Icon or F9 

2. Once these are set up you can easily select a category for future storage of a resource. 

3. You do not have to have a category set against a resource but it is recommended as the 

category search helps you find a required resource quickly. 

4. Set up a list of your most commonly used Suppliers in each resource section.  

5. Once these are set up you can easily select a category for future storage of a resource. 

6. You do not have to have a supplier set against a resource but it is recommended as the 

supplier search helps you find a required resource quickly. There are also reports which 

collate materials by supplier and would allow you to send buying lists directly to a supplier. 

These reports depend on the resource having a supplier set against them in the library. 

7. If you are working from a list and wish to save resources to the library, Use Menu> Admin 

Resource Library>Materials, Labour, Plant and Sub-Contractor. 

8. Once you have chosen a library add resources as follows: 

9. INSERT a new record (INSERT KEY) 
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10. Add the description (we suggest Brick Red rather than Red Bricks). When searching at 

estimating time you will be able to do a search on all resources starting with Br and bring up a 

list of all of your bricks.  

11. Tab or Enter to reach the other fields on this form. 

  

Code 

This is an optional field for finding a resource by code. Use this only for your most commonly used 

resources e.g. Cem1 = 25 kg bag of cement. 

 

Unit 

Any text description 

Kg, m, bags 

 

Rate 

The supply rate per unit, If you wish you may add in a waste factor at this stage. 

 

CATEGORY CREATION ON THE RESOURCE LIBRARY FORMS 

You cannot add delete or edit Resource categories from the drop down box on the Library Admin 

screen.  

You can create Resource categories when you are on a resource screen and you are saving a 

resource to the library directly from your build-up. the Save to Library Form 

If you wish to add delete or edit categories:- Menu>Resource>Show Categories (F7) See Resource 

categories 

 

EDITING AN EXISTING RESOURCE 

If you amend details of an existing resource, these amended details can optionally be updated in 

all Jobs that use the resource. Multiple records can be amended by Enabling Multi-Select and 

choosing the required records. You must run connect to update a Job of you have changed 

resource details. 

We strongly recommend that you run connect before submitting any Job unless you specifically 

do not wish to update the Job with new resource information. 

You can also disconnect a resource in a Job 

See Connect and Disconnect 

 

 

MASS UPDATE RESOURCES BY % 

 

You can increase or decrease a selection of resources in the resource library. 

 

Example 

ABC Supplies Ltd issues a 5% increase on all of its products. 

 

1. Whilst in Menu> Library>Admin>(Resource type) 

2. Using the search tools select the resources you wish to update (Search by Supplier ABC 

Supplies or Search by category (Timber) 

3. You now have a selection on a form 

4. Menu>Record> Adjust Rates and enter the percentage increase or decrease. 

5. The selected resources will be adjusted. 

 

Note: you can adjust rates on more than one record by selecting the Enable Multi-Select 

box and choosing the required records. All selected records will be adjusted accordingly. 
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SUPPLIER LIBRARY 

 Create a list of suppliers though you may add suppliers to this list at the time of saving the 

resource from one of your resource screens 

 Menu>Admin>Supplier Library:   

 Use Insert to add new suppliers and tab or mouse click to add database information regarding 

the supplier.  

This information will show on your reports especially the materials report which you can 

fax directly to your supplier if you have a fax modem. 

 

You cannot add delete or edit Suppliers from the drop down box on the Library Admin screen.  

You can create Suppliers when you are on a resource screen and you are saving a resource to the 

library directly from your build-up - the Save to Library Form 

If you wish to add delete or edit Suppliers:- Menu>Resource>Supplier Library  

 

It is advised to have a supplier against a resource as you can use this as a search filter.  
The supplier details also appear on some of the reports. Resources can be collated by supplier and 

this report can be faxed directly from Liberate to the supplier. 

 

 

CREATING DEDICATED LIBRARIES 

 

Liberate is supplied with sample databases and libraries that can be used and amended to suit 

your needs. 

 

It is also possible to create new set(s) of libraries to hold Items, Resources and Suppliers 

dedicated to a particular purpose. 

 

1. From either the Job or Item screen, select menu [Admin]> [Library Sections] (or use 

the Icons at top right of the menu bar) and the Library Administration screen will 

open. 

2. The box that appears contains a list of libraries and indicates which one is currently 

“active”. The default library is “Main” and if this is a new installation it will be the only 

choice. 

3. To create a new library click [Add]. 

4. Enter the name of your new library and click [OK]. 

5. The new library has now been created but is not yet active.  

6. To make a library active select from the list and click [Make Active]. 

7. The active library will now be indicated above the list of libraries – note that this shows 

the active library for administration purposes ONLY and not necessarily the active 

library that will be in use when you return to the Items screen. 

 

IMPORTANT 

 

If you have multiple libraries be aware that you MUST ensure that you have selected the 

appropriate “active” library when in the Items screen by menu [Library]> [Set Active 

Library]> then select the required library.  
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8. Select a resource library by clicking on the icons in the menu bar above – note that if 

this is a new library there will be no Items, Resources nor Suppliers listed. Alternatively 

you can return to the Job or Item screen by using the appropriate icon on the menu. 

9. A newly created library will have neither Resources nor Categories. These must be 

added as described  above using the Library Administration programme. 
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MARK-UPS PROFIT OVERHEAD AND DISCOUNT 

 

JOB MARK-UP %  
 

Definition: 

1. Mark-up is the value added on as a percentage of the cost of each resource. The mark-up is shown as 

a percentage on the Cost. 

2. The Cost + Mark-up is the selling price 

3. If main contractors discount is to be allowed, the selling price is the Cost + Mark-up + Allowance for 

discount . 

4. Note that the mark-up percentages shown on the Job screen are the Global mark-ups only. You have 

other options to mark up each individual resource type at Item level. These details are dealt with under 

the title Individual Mark ups 

 

HOW TO MARK-UP YOUR JOB 

Insert the Percentages by which you wish to mark up the Costs of the Current Job The resources will be 

marked up by the percentage shown on the job screen. 

E.g. If the materials total for a given item is £100.00 and the Mark-up is 10% the selling price is  

Materials £100.00 x 10% =£10 +(the  Materials) 100.00 = £110.00 

 

Any Items with an ITEM Mark-up will be excluded from this percentage. See below 

 

 

DEFAULT MARK-UPS 
You can insert default mark-ups in the User preferences so that all new jobs start with the defaults 

 

ITEM MARK-UP % 

EXCLUDING INDIVIDUAL RESOURCES FROM THE GLOBAL MARK-UP  
The Individual Resources of any Item may be marked up individually. 

1. Allocating an Item Mark-up Excludes the marked up resources from the Job Mark up 

2. On the Items Screen locate the Tab in the Bottom Half of the Screen which says  Item Mark-up 

3. Next to each Resource (Materials, Labour, Plant, Sub-Contractor) is a box. The following actions 

have effect: 

4. JOB:  Leaving the setting on this will mark the resource up by the Job mark-up as set in on the Job 

screen 

5. ITEM: Setting the drop down box to ITEM will activate the box to the right. Insert the desired 

percentage to mark up the resource. 

6. NONE: This will exclude the resource from any mark-up. This is useful for provisional sums 

 

7. Items mark ups will be reported in the Mkup% box on the Job screen and shown as an average for 

that resource type 

8. You can get a full analysis of the mark-up % for the whole job by printing the report titled 

9. "Item Mark-up" 

10. You may also use print to file to print this (and all reports) to a spreadsheet or word processor 

document. 

11. Totals displayed in a print to file report are not calculated. If using in a spreadsheet please add in 

the formula for the columns and the total at the bottom of the report. 

 

 

COST INFORMATION AND PROVISIONAL SUMS 

The following information is displayed 
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1. Cost - The totals of all the resources for the current job at cost 

2. Mark-up % -The percentage mark-up against each resource type. This is shown as an average and will 

reflect an average if any items are marked up individually at items level. 

3. Profit - The profit value against each resource type. This includes the value if any items are marked up 

individually at items level. 

4. Sell - The Cost + The Profit 

 

Provisional Sums 

Any  resources in any items which are flagged for NO MARKUP at items level in the individual resource 

screens are shown as a collection in the Provisional sums box. Provisional sums are set using individual 

mark-up on the Items screen 

 

Totals 

Cost Total 

The totals of the: Costs of the resources + Provisional sums  

 

Sell Total 

The total of the Marked up resources + Discount if applicable + Provisional sums 

 

Items Total 

This is a unique feature of the Liberate Estimating system to ensure the highest degree of accuracy in 

submitting bids and quotations 

 

This box allows a comparison between the following items 

The Materials, Labour, Plant and Sub-Contractor Resources + Profit (+ Provisional Sums) (+Discount 

if applicable) 

 

and  

 

The sum of the individual items on the items screen. 

 

 The purpose of this comparison is to highlight any rounding differences. 

 Rounding differences may occur especially with high quantities at very low rates where a fraction 

of the currency unit occurs. 

 In these cases a rounding difference will be shown 

 Rectify the difference by increasing the amount of decimal places shown on the Options 

menu (>File >Options>Money) until a minimal rounding difference is achieved. 

 

 

PROVISIONAL SUMS 

Liberate has a facility to flag items set as provisional sums so that they are not subjected to mark-up. 

 

 A provisional sum is a sum set provisionally set aside for works that will be required but has not 

been fully defined as yet. 

 Provisional sums are not usually subjected to mark-up or discount. 

 As with Item Mark-ups, you may individually mark up a collection of resources within an Item at 

the bottom of each resource screen 

 You have 3 options within each resource type for any Item 

 At the bottom of each resource screen you will find 3 check boxes headed 

 

"Mark-up for all resources in this Item" 

1. Job:- This is the default and will subject these resources to the mark-up as set in on the Job 

screen. 
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2. None:- Selecting this option will subject this set of resources to No mark-up or discount .The 

value of these resources will be shown in the provisional sums box on the Job screen. 

There may be other Provisional sums in the Job. In this case the Provisional sums box will 

show a collection of these sums. 

3. Item:-  This allows you to set a value against this set of resources only and will exclude these 

resources from the Job Mark-up 

 

If there are other resource types within this item you should set them if you do not wish them to be marked 

up by the Job mark-up.  

 

 For example if you place a None mark-up against materials but there are labour and plant resources in this 

item, they will still be subjected to the Job mark-up unless you set their mark-up status to none as well. 

Provisional sums are however usually placed against only once resource type. 

 

 

OVERHEAD 
Adds overhead as a % of resources cost 

Resources in your job that are individually marked up are excluded from overhead. You should make any 

adjustments as necessary to cover these excluded items. 

 

Example 

If a value of 20 is placed in your labour mark-up box on the Job screen (i.e. you wish to mark up ALL the 

labour in your Job by 20 %) the formula is as follows: 

 

Labour total x 1.10 = Selling Price of Labour 

 

If in addition to this you have an overhead on the Job of 10 %, then the costs of the labour will be marked 

up x 10% and added to the % mark-up on the labour as follows: 

 

Labour cost  total x 1.10  

+ 

Labour cost total x 1.05 = Selling Price of Labour 

 

 

Important: Items with Item mark-up (as opposed to Job Mark-up) 

  

If a resource or set of resources has an Item Mark-up on it then this item will be EXCLUDED from any 

overhead mark-up. You will have to adjust the item mark-up to compensate for this. 

So if the Item mark up is 20% and the Overhead is 10%, the Labour on this item will only be marked up by 

the Item mark up of 10%. 

 

Provisional sums and Overhead 

As above any item set with an Item mark-up of  “None” will be excluded from the Overhead % as set in in 

the Overhead box 

 

 

All labour resources in the job EXCEPT those flagged individually for item mark up or provisional sums will 

be subjected to the following: 

 

Selling Price = Labour Resource Totals   +    20   x  Resource Totals) 

            100 
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or 

 

Resource Totals x 1.30 

 

Discount 

This is main contractors discount (MCD)  and allows the addition of a discount for deduction at a later stage. 

 

This is a figure to be allowed on the value of the Job which will be deducted at a later stage usually where 

the party submitting the bid is a subcontractor to a main contractor 

 

Discount is calculated as follows: 

 

(M+L+P+S)+Profit  

(1–discount%) 

 

e.g.  The Job value with profit is £10000.00 

 The Discount allowance is 2.5% 

 

10000.00     

1-(2.5/100)   = 10256.41 so that 

 

10256.41 - 2.5% = 10000.00 

 

We recommend that discount only be added at submission of the Job as any figure in the discount box may 

distort your analysis of Mark-up percentages and Profit values. 

 

 

 

 

VAT 

You can display your Bill of Quantities report with VAT. To activate the VAT function use the 

2 Job Options button on the job screen. The Vat rate may be varied under  the program 

options button from the toolbar. 

 

FIND AND REPLACE 

If you have used a particular resource through your estimate and wish to replace that resource 

with another resource you can use the Find and Replace Resource function. 

Example 

You have quoted using Brick Type A at £800.00 /1000 but the job is over budget. 

You have been instructed to replace the Brick at 800/1000 with a brick at £500.00/1000 

 

The find and replace resource will replace all instances of a particular Library resource with 

another chosen library resource. 

 

Find Resource and Replace resource are accessed from Edit whilst on the Job screen 
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REPORTS (SEE ALSO PRINT TO FILE) 

OVERVIEW 

 Reports are generated from the reports button on the Menu 

 There are a number of pre-set reports which will be fully explained later in this section 

 You can generate the reports directly from Liberate or you can export reports to your 

spreadsheet or word processor. 

 All reports are set for A4 paper in the UK 

 You may fax your reports to a recipient if you have fax software installed or generate 

reports to PDF  

 

HOW TO GENERATE REPORTS TO YOUR PRINTER 
1. Reports may only be generated from the active Job 

2. Select Reports from the Menu on either the Job or Items screen 

3. Select the report you require 

4. Select the options you require by placing a tick in the appropriate box. 

5. The report will appear for viewing on your screen 

6. Use the icons at the top of the reports screen to enlarge or reduce  the screen view of 

each report. 

7. Use the arrows to view each successive page or first and last pages of the report 

8. Press the Printer Icon on the top left 

9. The printer dialogue box will appear 

10. If required change or set up your printer 

11. If required select the pages that you wish to print. 

12. If required select your fax printer driver if you wish to fax a report directly to a fax 

recipient 

13. Select OK 

 

Note 

Any last minute changes or additions you have made in your Job may not appear in your latest 

report until that change is saved by either pressing the green tick on the taskbar or switching to 

another screen. 

 

Liberate saves your last entry as follows: 

1. When you create a new record 

2. When you flick to another screen 

3. When you exit 

4. When you press Ctrl+S 
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PRINTING REPORTS TO A FILE (PRINT TO FILE) 

OVERVIEW 

 

The recommended format is Excel 

You can generate different reports and combine them together in Excel 

You can export your report to a Spreadsheet, Word processor, or Text file  

This enables you to edit the presentation of your document or work with the data. 

Data edited in other programs is not saved back to Liberate.  

The following steps will show you how to export your data. We assume that you have some 

knowledge of the software system you are exporting to.  

This help will not guide you through working with the data in the new environment. 

 

Important 

When you print to file the totals of a report will not be calculated totals. 

There are no formulae in a report sent to a file. 

You should reset the formulae to verify the correct totals of columns and dependants. 

 

Print to file is not a perfect report export. Some of the data will be transposed to other columns or 

rows in a spreadsheet. 

You will have to move some of the data around to get a perfect report in this format. You will also 

have to set column widths and text wraps in Excel 

(It's still easier than retyping a whole report into a spreadsheet.) 

 

 

 
 

 

Follow steps above of the instructions above "How to generate Reports to your printer" 

To print to a File 

Generate the report from the Reports menu 

Once you see the report on screen click the printer icon on the top left 

1. Tick the print to file box as shown below and select the type of file you require select 

the file type from the drop down box of the file that you wish to export to (Excel file 

or RTF PDF etc.) 
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2. Adjust the Where: box to set your location 

3. Press OK 

4. Choose the location using the  browse box (with 3 dots) and rename the report of 

necessary 

5. Each report will by default have the same name. You should rename your reports if 

you do not wish them to overwrite previously generated reports of the same name. 

6. Select Save if you have changed the file name and you will revert back to the Print to 

File dialogue box 

7. Press OK and the report will generate to the file name that you selected in the location 

that you selected or set up. 

8. Open the file using your Word processor or spreadsheet or PDF application.  

 

 

INSERTING A LOGO OR CUSTOM TEXT INTO THE REPORT 
 

Generate the report to your screen 

At the top left you will see a button to add the logo 

 

 
 

 

You will see browse buttons and boxes to place your desired text 

 

 

• Ensure that your logo is 

preformatted to fit into the available 

space. 

• You cannot resize your logo from 

within Liberate 

• Your logo should be the right size to 

fit in at the top of your report and 

should be approximately 350 x 80 

pixels. 

• You can use “Paint” which comes as 

part of Windows or any other graphics 

program to check the properties of your 

logo and to resize it to  

Add in the desired information 

• Filename of the logo 

• The text you wish to insert 

• Tick the “Visible” buttons to toggle 

the logos on and off 
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SECURITY PASSWORDS ACCESS AND LEVELS 

 

Notes 

Liberate is issued universally with the Username and Password as Superuser /Demo 

You cannot delete the Superuser account but we strongly recommend that if security is an issue that you 

change the Superuser password. 

 

Tender security 

If data security is an issue in your organisation you should consider using the security features in Liberate 

There should be a minimum amount of people in any organisation who are set as Admin users 

Only Administrators can add other users and change passwords 

Administrators are all set at Job level 5. 

 

If an Administrator sets a user with a level below 5 (or 4 or 3 etc.,) users with level restrictions will not be 

able to view jobs that are above their designated level. 

If your staff have an opportunity to pass your information on to competitors, you should strongly consider 

managing your security as follows. 

 

• Change your Superuser password from the Issued Demo 

• Ensure that a record of this password is kept as we will not be able to assist you with lost passwords 

at the Superuser level if this is lost. 

• Make sure all your new users are registered as level 4 or below 

• You will then change the access level of tendered jobs to allow access to lower level users once 

the tender security is no longer an issue for any selected Job. 

 

 

User Levels 

Each Job can have a user level assigned to it. 

Users can only access Jobs that are their password level or below. 

Only the user with Level 5 the password may access the users and password screen. 

User levels are adjusted on the drop down on the Job screen. 

You can set a Job to a lower user than yours but not a higher one. 

If a Job is not visible to you ask a higher level user to set it to your user level for access. 

 

 

PASSWORD  

Once you have started Liberate you will see a password screen. 

The user name is Superuser and the password is Demo. Enter these and press Login 

If you have set up passwords you will need to enter your user name and password to enter the system. 

Ensure that the cursor is flashing in the User field. Use your tab key () to navigate 

The password administration function is only available to level 5 users 

If you have set up passwords you must use these User names and passwords in conjunction with each other 

 

There are five password levels numbered 1 to 5 

1. These are found under the menu item Admin. which can be accessed from the Job screen 

2. A user does not have to have a password but must have a user name 

3. The User field cannot be blank 

4. 5 is the highest level 

5. The level 5 users may add and allocate users and passwords 

6. Your system is delivered with Superuser as the level 5 user with DEMO as the password (Not case 

sensitive) 

7. You cannot delete Superuser although you may (and it is suggested that you do) change the password. 
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8. There may be multiple users on each level 

9. Only level 5 users have access to the password administration box. 

10. On setting up a new user the password administrator may allocate whether the new user has access 

to maintaining the libraries by placing a check mark in the  

Lib Maintainer check box
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NAVIGATION 

USING THE KEYBOARD 

To go to… 

The Items screen  >Alt+I 

The Job Screen  >Alt+J 

Materials  >Alt+M 

Labour   > Alt+L 

Plant   >Alt+P 

SubContractor  >Alt+S 

 

To navigate your cursor to the description box on the Items screen   Alt+D 

USING  ICONS 

There are a number of Icons at the top of your screen. Click the following icons to navigate in Liberate 

To go to… 

The Items screen    I  

The Job Screen       J 

Materials   M 

Labour     L 

Plant    P 

SubContractor   S 

 

The Tool bar and Icons 

The tool bar is contains Icons for the most commonly used tasks 

You can remove or set the tool bar using Menu>View >Toolbar 

Holding your mouse cursor over any icon will display a brief description of the Icons functions 

More detailed description is shown simultaneously at the bottom of the screen on the status bar. 

 

The following Icons are available 

 

 J I M L P S   Navigation to Items Job Materials, Labour, Plant and Sub-Contractor screens 

 Insert a new record 

 Append a new record 

 Duplicate a record 

 Save Changes 

 Cancel changes  

 Delete the current record 

 Select from Library (Items if on the Items screen or resource from resources screens) 

 Saves to the Library (Items if on the Items screen or resource from resources screens) 

 Connect  

 Disconnect 

 View Marked up Totals 

 Displays the Take-off pad whilst on a materials screen 

 Activates the Resource library maintenance screen 

 Activates the Items library maintenance screen 

 Activates the Supplier library maintenance screen 

 Displays the Options dialogue 

 Exit 

 

USING THE MENU BAR 

The above commands are available by using the menu bar. 

To select a menu item: 

 either Mouse click the menu item 

Use ALT+ The underlined letter on the menu bar. e.g. ALT+F will activate the file menu. 
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Select the desired function. 

From the View Menu Select Items Materials Labour  Plant and SubContractor Screens. 

 

HOTKEYS 

 

 F2 All screens   Edit text 

 F4 Items/Resource   Copy record 

 F5 Items    Shows the Rates and Totals with mark-up. (On and Off) 

 F7 Resource screens  Brings up the Comment box from a resource screen 

 F7 Library Categories  Shows the library categories whilst in library Admin 

 F9 Items screen   Select from Items Library if on Items 

 F9 Resource screens  Select from Resource Library if on Resources 

 F12 Items/Resources   Adds a new record  

 Insert  Items/Resources  Inserts a new Record 

 Ctrl+Del    Deletes the current record
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MENU COMMANDS 

The following commands and explanations of their functions are available through the Menu. 

File 

  

 Keyboard 

Short Cut 

Job Takes you to the Job Screen    Alt+J 

Items Takes you to the Items screen  Alt+I  

Materials Takes you to the Material screen  Alt+M 

Labour Takes you to the Labour screen  Alt+L 

Plant Takes you to the Plant screen  Alt+P 

Sub-contractor Takes you to the Sub-contractor screen  Alt+S  

Options 

 

Money 

 

 

 

Number 

 

Labour 

 

 

 

Colours 

 

Reports 

Allows you to set the following options: 

 

 Currency symbol and number of decimal  places. The currency 

symbol is the default windows symbol as shown in the 

International folder under Windows Control Panel 

 

Sets the decimal places for the quantity 

 

Sets the default labour rate for new Jobs 

Sets the number of hours per day to calculate the total mandays 

on the Job 

 

Allows optional use of colours for the various screens 

 

Sets the target printer from the printer list in your Windows 

printers folder. 

 

Sets the directory for reports that you prefer to export to your 

word processor or spreadsheet 

 

 

 

Exit Exits the system (Alt+X) 

 

Edit The edit menu offers text editing functions for text only in any field  

Cut Cuts selected text for pasting elsewhere Ctrl+X 

Copy  Copies selected text Ctrl+C 

Paste Paste cut or copied text to a desired text location Ctrl+V 

Select All Selects editable text in a text field Ctrl+A 
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View   

Toolbar Allows the toolbar containing the icons to be viewed  

Status bar Shows the status bar on the bottom of your screen  

Marked up 

Totals 

Allows you to view your items with mark-up and discount reflected 

(Items screen only) 

 

Resource Totals Will display or hide the resource titles at the top of your Items 

screen 

 

Pad Brings up a pad against each materials record for calculating take 

offs measurements etc. The calculations are stored for future 

reference (Items screen only) 

 

Restore Default 

Layout 

You may size the grids of all the screens or place columns in an 

order which best suits your style of thinking. Using this function 

will restore the layout to the system defaults 

 

 

Job Only available on the Job Screen Alt+J 

Select /Change 

Job  

Make another Job Active. The Job currently active is not included 

in the Job list 

 

Create New 

Empty Job 

Creates a new Job  

Close Closes the Active Job  

Delete/Reorder 

Job 

Delete a Job or change the order of Jobs on the list shown using 

the arrows at the bottom of the screen 

 

Save Changes Saves your last changes.   

Cancel Changes Undoes your last change  

Import   Imports an archived or previously exported job or selection of Jobs 

from disk the network or your hard disk. This feature works only 

with Liberate .lji file types. Imported Jobs are appended to the 

existing list and do not overwrite Jobs of the same name. 

 

Export Exports to an archive a Job or selection of Jobs to disk the network 

or your hard disk. This feature creates  Liberate.lji file types 

 

 

Reports   

Selection of 

Reports 

Select a report to print to printer or Print to file e.g. Excel Lotus 

123 

 

 

Admin   

Resource Li-

brary 

Access any of the Resource Libraries ( Materials, Labour, Plant and 

Sub-Contractor) for adding deleting or changing details of the 

resources contained therein. 

 

Items Library Access the Items Library ( Built up Items) for adding deleting or 

changing details of the resources contained therein. 

 

Supplier library Add or edit supplier names and address details which will appear 

on some of the reports 

 

Authorised 

Users 

Admin screen accessible only to level 5 users to add new users and 

passwords 
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Record Available only from the Items Screen Alt+R 

First Navigates to the first record of your Items Ctrl+Home 

Next  Navigates to the next record of your Items Alt+N 

Previous Navigates to the previous record of your Items Alt+P 

Last Navigates to the last record of your Items Ctrl+End 

Edit Allows the editing of user input text and numbers F2 

Edit Comment Edits the comment for that record F7 

Insert Inserts a new record above the current record Insert 

Append Adds a new record after the current record F12 

Duplicate Copies the current record F4 

Save Changes Saves changes Ctrl+S 

Cancel Changes Cancels any changes you have made to the current record only. Ctrl+Back-

space 

Delete Deletes the current record. Ctrl+Delete 

 

Library   

Select from  

library 

If you are on the Items Screen- this selects the current Items from 

the Items Library into your Items screen 

 

If you are on a resource screen this selects resources from the 

appropriate resource library 

F9 

Save to Library If you are on the Items Screen- this saves the current Item to the 

Items Library  

 

If you are on a resource screen this saves the current resource to 

the appropriate resource library 

F10 

Connect Connects resources back to the library. All resources are auto-

disconnected when a Job is no longer the active Job. i.e. when 

another Job replaces it as the active Job. 

Run connect before submitting any Job or where you have made 

changes in the library and wish these changes to be reflected. 

 

Disconnect 

Current  

Resource 

Disconnects the current resource from the library to prevent 

updating to that resource only 

To disconnect a Job Close it and open it and do not run connect 
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OTHER FEATURES OF LIBERATE 

OPTIONS 
Options are set in the options sub menu 

Access the Options from Menu>File>Options 

 

MONEY 
Sets the amount of decimal places for your rates and totals. There are no residual values. 

If you set to two decimal places all figures are rounded to two decimal places. 

If you set to four decimal places all figures are rounded to four decimal places. 

Use this feature to eliminate rounding differences that show up on the Job screen difference box. 

 

Select whether you wish to display the currency symbol as set in your Windows control panel. 

Select whether you wish to use a thousands separator. 

 

NUMBERS 
Sets the decimal places of the quantities fields 

 

LABOUR RATE AS SET IN OPTIONS  
Sets the default labour rate for all new jobs on the Job screen 

Sets the default hours per day for all new Jobs on the Job screen 

 

COLOURS 
View the screens with colour coding or with white backgrounds 

 

REPORTS 
Select your default printer 

 

WARNINGS AND PRECAUTIONS. GENERAL MAINTENANCE 

 

PRICE UPDATING : CHANGES TO YOUR ESTIMATE 
Please ensure you flick to the Job screen before outputting any reports after making any 

changes. This ensures that all changes are reflected in the latest reports 

 

UNCONVENTIONAL EXITS 
You should always exit your Liberate system using a normal shutdown. Exiting by closing down 

your machine whilst the program is still open could result in file corruption. 

If an instance of this has occurred please contact us. We can examine files and in some cases repair 

them. 

For safety you may also wish to export the list of current Jobs to a backup file. Reinstall the Jobs 

Database (See installation notes) This installation will overwrite your current Jobs database and 

you will lose all of your current information if you have not backed up. 

Please call or email us if you are unsure. 

 

GENERAL MAINTENANCE 
It is recommended that you export your entire Jobs database regularly and then re-import 

the backup file into a clean database which can be downloaded from our website.  

 

1. Simply run the program JOBSEMPTY.EXE.  
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2. THIS WILL OVERWRITE YOUR JOBS DATA BASE. YOU MUST BACKUP YOUR DATA FIRST USING 

EXPORT.  

3. Please phone for support if you are unsure. 

4. You will have to use the standard passwords to enter the system. Please reset your passwords 

up again using Admin  

5. Remember this will overwrite all of your existing Job information. If you have not backed up 

to a file your Jobs will be lost.   

6. See the notes on Export and Import.   

7. Once you have completed an export your data will be safe.  

8. Phone us to check if you are unsure before running this procedure 

 

You should run this procedure after any unconventional exits even if your data appears to be in 

order 

 

BACKUP YOUR DATA FILES – THIS IS IMPORTANT. DO IT REGULARLY 
 

Backup your Jobs and Library regularly using WINZIP  or an  archiving program. Alternatively simply 

make a copy of the folders on another drive or a CD 

 

The easiest way is simply to make a copy of the folders below and store them in a separate 

directory. 

 

Liberate must be closed when you do this. 

 

Personal Edition 

Jobs Folder: C:\Users\user_name\AppData\Roaming\Liberate 

Library Folder: C:\Users\user_name \AppData\Roaming\Liberate 

 

Multi-user Edition 

The default path for the data files is either:  

\Server Name\User named directory\Jobs 

 \Server Name\ User named directory\Library 

 

If you are not sure where the server files are stored, you can see this by starting Liberate 

and looking in Help/ About. 

Press the blue i button and look down the list for these paths. 

 

See also Import and Export 
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OTHER INFORMATION FOR USERS 

LICENCE KEYS 

VERSION NUMBERS 

DATABASE PATHS 
 

You will find other information such as that listed above under the Help /About section 

Then press the blue ‘I’ button 

You can also use the Clipboard icon on this screen to copy and paste the information to a 

file 
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TUTORIAL 

This tutorial will take you 1.5 hours. On completion you will be able to estimate with Liberate 

 

Part 1 General Familiarisation 

 

Start Liberate 

1. The password screen will appear.    

2. Type Superuser as the User name  

3. Type Demo as the Password 

4. Press Login. If you have converted from Liberate Edition 2 you may use your old passwords 

5. You’re now at the Job screen. There are two a few sample jobs an separate folders. 

6. Select Sample 1 by clicking it once with your mouse 

7. Press the I Icon on the Taskbar or press Alt + I on your keyboard 

8. You are now at the Items screen 

9. The screen is divided into 3 main sections. See the Items Screen section of this manual for 

more details 

10. Select any item on the Items list on the top right hand section of the screen. 

11. Press the Materials Tab on the bottom half of the screen to view the materials that make up 

the Item 

12. Press the Labour Tab to view the labour resources that make up the item 

13. Press the Plant Tab to view the Plant resources that makes up the item 

14. Press the Sub -Contractor Tab to view the subcontract resources that make up the item  OR 

15. Press Alt+M, Alt+L, Alt+P, Alt+S to cycle through these screens again using the keyboard. 

16. Click on the Items section again or Alt+I to return to the Items screen 

17. Click on the J Icon or Alt+J to return to the Job screen 

 

PART 1b  Selecting another existing Job or creating a new Job 

18. From the Job Screen (J) or Alt+J, Select Menu>Job > Select/Change Job or Create New Empty 

Job. 

19. Give the new Job a name by typing the name in the description box  

20.  Call the new Job -Test Job 1. 

21. Click on the Hours /Day box and ensure that the value here is satisfactory to you. This 

value influences the number of Mandays used for the whole Job. Enter 8 (hours per day) 

22. Click on the Labour rate box and type the cost rate per hour with which you would like to work 

[10.50] (Note you can set this rate in >Menu >File>Options>and then select the labour tab. 

Each new Job will start with this Rate in the Labour Rate box 

23. Click or TAB or mouse click in each box to fill in Job mark-up percentages on each of the 

resources. 

 

Part 3 Adding Items to the Job 

24. Press the I button on the toolbar or[Alt+I] to take you to the Items screen to begin building up 

your estimate. 

25. On the Items screen and ensuring that you are anywhere on the top half of the screen (the 

items section) create a new record (F12) or use the toolbar 
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26. Your cursor will be flashing in the description box (the white text area on the top left of the 

items screen) waiting for you to title the Item. If your cursor is not in the description box, 

either click the box with your mouse or Type ALT+ D to navigate to the description box 

27. Type a description  " Supply and lay brick paving" 

28. Tab to the Code box and Type a code. The code is simply any alphanumerical code, which you 

wish to use for reference on your reports or the code issued to you on the Bill, which you are 

pricing from. e.g. A,B,C or 1.1, 1.2, 1.3 etc  

29. Press Return and the cursor jumps to the Quantity field. Enter a quantity [20] 

30. Press Return and the cursor jumps to the Units field. Type a unit [m2]. Do not press Return 

after this operation, as this will create a new record. If you have pressed Return and created a 

new record, simply ensure that you re-select the item that you titled previously and wish to 

begin pricing 

You have now created an Item. The next step is to begin selecting and adding the resources that 

make up the item. 

 

Part 4 Adding resources to the Item 

You are now going to add two materials. One material will be from your library, the other will be 

a new resource that you will save to your library. 

Your cursor should still be in the unit's field (or anywhere on the Item you have just created: If the 

cursor has jumped to a new empty item, simply reselect the newly created item using your mouse 

or up/down cursor keys. This ensures that the resources you will now be adding are the "children" 

of the Item that is being priced.  

 

31. Click the materials tab or Alt+M 

32. Create a new record F12 (There is already a record there but you cannot type into it until 

you've pressed F12 

33. Type Bricks Ibstock Aldridge Paviors and press Return ( 

34. In the quantity field type the quantity of bricks that you will need  [1050] this includes 5% 

waste 

35. Type the unit  "each"  (or  /1000 if you prefer)  

36. Type the Rate  .35(or 350 if you prefer. You must also change your quantity  to 1.05 rather 

than 1050 if you are pricing bricks as a /1000 unit rather than each) 

37. Now you will save this resource to the Materials resource library.  

38. Press F10 

39. On the dialogue Box Fill in the information required 

40. Code (optional) this will enable you to find resources easily by code 

41. Category (suggested) Open the drop down box and type the first few letters of the required 

category. Choose BRICKS PAVING  If the required category is not found you can add a new 

category here. 

42. Supplier (suggested) Selecting a supplier clarifies many of the reports and searches.  If the 

required supplier is not found you can add a new category here. 

43. Press the SAVE TO LIBRARY button 

44. Now you will recall a previously stored item for the library 

45. Create a new material record F12 

46. Type “ty” (For Type 1) and press F9 

47. A list of "type 1" prices appears 

48. Select an appropriate price from the list  
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49. Press the Retrieve into Job button 

50. Add a quantity (Use the pad if you wish to calculate the quantity. It will also store your 

calculation. The pad is the Icon with the Calculator on it and is available against each materials 

record. 

51. You can also press f9 on a blank description and use the library search filters at the bottom of 

the library screen. 

52. You will note that against both items there is a Y in the Lib column to indicate that this resource 

is connected to the library. Any changes to the library will update your Job once you run the 

Connect function from the Library menu 

 

Now for the Labour 

53. Select the labour tab or Alt+L 

54. Type a labour description: Excavate paving area  

55. Add a Men quantity (e.g. 2 men for 8 hours) Type "2" under men   

56. Type "8" under Quantity  

57. Press F12 to create a new record 

58. Type "Lay type 1":  Men 2   Quantity 5   

59. You will have notice that the rate that you set in under Labour Rate on the Job screen comes 

in automatically on each new record. 

60. Change the Rate on the Job screen and see what happens. 

61. You can also access the Labour library from the Labour resource screen by pressing F9 and 

using other library labour rates. 

 

PLANT 

62. Click on the plant screen and exactly the same way. Add an excavator from the plant library. 

If you are not sure what to do:- 

63. F12 For a new record 

64. Exc +F9. 

65. Select the appropriate resource from the library list that appears  

66. Add the Quantity:  1 (the unit hour, day or week has been brought down as part of the rate 

from the library) 

 

At this stage we will assume that your rate has been built up. Look at the top of your screen and 

view the individual resource totals in the summary boxes.. Is the total the same as the total on the 

Items grid? 

If not Press Ctrl+S to save your last entry 

Is it the same now? 

If not increase the number of decimal places on the Money Tab in the File> Options menu. 

 

NOW FOR THE CLEVER BIT (Part 1) 

Now you will save this built up item to the Items library so that you can use again and again in 

future build-ups no matter what the size.  

67. Ensure that you are on the Items section of the Items screen: (anywhere on the top half i.e. 

not on a resource screen) 

68. Press F10 (save to the library) 

69. On the dialogue box that appears you will note that some details are already filled in for you. 

70. Select a category to save this brick paving item to. Open the drop down box at Category 
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71. Type Br to go the brick sections and select the Category called Brick Paving (You can also create 

New categories here if the category that you require does not exist) 

72. Add to or amend the comments if you wish 

73. Press the SAVE to LIBRARY Button 

 

This next step will show you how to use the information you saved in a new item. The new item 

can be in the same Job or a different Job. 

 

Tutorial: The Clever Bit - Part 2   

Retrieving a Built-up Item from the Items Library. 

 

In this section of the tutorial we will only examine bringing in a single item from the Items Library 

and Appending (adding on to the bottom) of your estimate 

 

74. Ensure that you are on the Items screen 

75. Press F9 to access the Items Library 

76. On the bottom left of the library grid which now appears, click the "Category" option. 

77. Open the drop down box and Type Br (for brick paving) or scroll down to the required category.  

78. Select the required category by pressing your enter key or clicking it with your mouse. 

79. You will also see a choice of view heights at the bottom right of the screen. Select double or 

triple height if you wish. 

80. You can see more info about the items listed by scrolling the grid to the right. You can also re-

order the columns by dragging the titles and set the widths of the individual columns. These 

settings will remain in place until you run the Restore default Layout from the view menu 

81. Press the retrieve into Job button at the bottom right of your screen 

82. At this point a box appears with the Quantity highlighted. This is the original quantity with 

which you built up the Item  

83. Change the quantity to the required quantity of your new Item [50] 

84. The Item with all of its resources will now be brought into the Job with all of its resources for 

the required quantity. 

85. You may alter the quantities, add or delete resources at this point and if you wish, re-save the 

Item back to the library as a new Library Item  

86. You may if you wish re-order the Items on your list using the Blue arrows on the bottom of the 

items list 

87. You may give any of the resources individual Item mark ups. See the notes on this section 

88. You may adjust the resource rates in the resource libraries. These changes will not take effect 

until you run the Connect function. (See the notes on this under the Resource library section) 

 

In the next section of this tutorial you will learn some of the more advanced features of the 

Liberate Estimating system 

Summary 

You have seen how to: 

 

 Create an Item     >F12  From the Items screen 

 Add resources to an Item     >F12  from a resource screen 

 Save a resource to the resource library  >F10  from any resource screen 
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 Retrieve a resource from the library  >F9   from any resource screen 

 Save an Item to the Items library   >F10  from the Items screen 

 Retrieve an Item to the library   >F9 from the Items screen 

 

   



 

 

 86

LICENCE AGREEMENT 

End-user license agreement for Liberate Estimating software 

 

IMPORTANT—READ CAREFULLY:  

This Liberate Estimating  License Agreement ("Licence agreement") is a legal agreement between you (either an individual or 

a single entity) and Liberate Estimating  for the Liberate Estimating software product identified above, which includes 

computer software and may include associated media, printed materials, and "online" or electronic documentation 

("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the 

terms of this LICENCE AGREEMENT. If you do not agree to the terms of this LICENCE AGREEMENT, do not install or use the 

SOFTWARE PRODUCT; you may, however, return it to your place of purchase for a full refund. 

 

SOFTWARE PRODUCT LICENSE 

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual 

property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

 

1 GRANT OF LICENSE. This LICENCE AGREEMENT grants you the following rights: 

 

Applications Software. You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same 

operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may 

make a second copy for his or her exclusive use on a portable computer. 

Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network 

server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you 

must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from 

the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers. 

 

1 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 

Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or 

disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable 

law notwithstanding this limitation. 

Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be 

separated for use on more than one computer. 

Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.  

 

Support Services. Liberate Estimating may provide you with support services related to the SOFTWARE PRODUCT ("Support 

Services"). Use of Support Services is governed by the Liberate Estimating policies and programs described in the user manual, 

in "online" documentation, and/or in other Liberate Estimating-provided materials. Any supplemental software code provided 

to you as part of the Support Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and 

conditions of this LICENCE AGREEMENT. With respect to technical information you provide to Liberate Estimating as part of 

the Support Services, Liberate Estimating may use such information for its business purposes, including for product support 

and development. Liberate Estimating will not utilise such technical information in a form that personally identifies you. 

 

Software Transfer. You may permanently transfer all of your rights under this LICENCE AGREEMENT, provided you retain no 

copies, you transfer all of the SOFTWARE PRODUCT (including all component parts, the media and printed materials, any 

upgrades, this LICENCE AGREEMENT, and, if applicable, the Certificate of Authenticity), and the recipient agrees to the terms 

of this LICENCE AGREEMENT. If the SOFTWARE PRODUCT is an upgrade, any transfer must include all prior versions of the 

SOFTWARE PRODUCT. 

 

Termination. Without prejudice to any other rights, Liberate Estimating may terminate this LICENCE AGREEMENT if you fail to 

comply with the terms and conditions of this LICENCE AGREEMENT. In such event, you must destroy all copies of the 

SOFTWARE PRODUCT and all of its component parts. 

 

UPGRADES. If the SOFTWARE PRODUCT is labelled as an upgrade, you must be properly licensed to use a product identified 

by Liberate Estimating as being eligible for the upgrade in order to use the SOFTWARE PRODUCT. A SOFTWARE PRODUCT 

labelled as an upgrade replaces and/or supplements the product that formed the basis for your eligibility for the upgrade. You 

may use the resulting upgraded product only in accordance with the terms of this LICENCE AGREEMENT. If the SOFTWARE 

PRODUCT is an upgrade of a component of a package of software programs that you licensed as a single product, the 

SOFTWARE PRODUCT may be used and transferred only as part of that single product package and may not be separated for 

use on more than one computer. 
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2 COPYRIGHT. All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, 

animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE PRODUCT), the accompanying printed 

materials, and any copies of the SOFTWARE PRODUCT are owned by Liberate Estimating. The SOFTWARE PRODUCT is 

protected by copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any 

other copyrighted material except that you may install the SOFTWARE PRODUCT on a single computer provided you keep the 

original solely for backup or archival purposes. You may not copy the printed materials accompanying the SOFTWARE 

PRODUCT. 

 

3 DUAL-MEDIA SOFTWARE. You may receive the SOFTWARE PRODUCT in more than one medium. Regardless of the type or 

size of medium you receive, you may use only one medium that is appropriate for your single computer. You may not use or 

install the other medium on another computer. You may not loan, rent, lease, or otherwise transfer the other medium to 

another user, except as part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT. 

 

MISCELLANEOUS 

Should you have any questions concerning this LICENCE AGREEMENT, or if you desire to contact Liberate Estimating for any 

reason, please contact Liberate Estimating  +44 +01252 +795030 or write to: Liberate Estimating , 14 Upper Bourne Lane, 

Farnham Surrey, GU10 4RQ  

 

LIMITED WARRANTY 

Liberate Estimating warrants that (a) the SOFTWARE PRODUCT will perform substantially in accordance with the 

accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) any Support Services provided 

by Liberate Estimating shall be substantially as described in applicable written materials provided to you by Liberate 

Estimating, and Liberate Estimating support engineers will make commercially reasonable efforts to solve any problem issues. 

To the extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if any, are limited to ninety (90) 

days. 

 

CUSTOMER REMEDIES. Liberate Estimating's and its suppliers' entire liability and your exclusive remedy shall be, at Liberate 

Estimating's option, either (a) return of the price paid, if any, or (b) repair or replacement of the SOFTWARE PRODUCT that 

does not meet Liberate Estimating's Limited Warranty and which is returned to Liberate Estimating with a copy of your receipt. 

This Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted from accident, abuse, or misapplication. Any 

replacement SOFTWARE PRODUCT will be warranted for the remainder of the original warranty period or thirty (30) days, 

whichever is longer. Neither these remedies nor any product support services offered by Liberate Estimating are available 

without proof of purchase from an authorised source. 

 

No other warranties. To the maximum extent permitted by applicable law, Liberate estimating and its 

suppliers disclaim all other warranties and conditions, either express or implied, including, but not limited to, 

implied warranties of merchantability, fitness for a particular purpose, title, and non-infringement, with 

regard to the software product, and the provision of or failure to provide support services. This limited 

warranty gives you specific legal rights. You may have others. 


